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NOTICE

The information contained in this document is believed to be accurate in all respects but is not warranted by Mitel
Networks™ Corporation (MITEL®). The information is subject to change without notice and should not be construed
in any way as a commitment by Mitel or any of its affiliates or subsidiaries. Mitel and its affiliates and subsidiaries
assume no responsibility for any errors or omissions in this document. Revisions of this document or new editions of it
may be issued to incorporate such changes.

No part of this document can be reproduced or transmitted in any form or by any means - electronic or mechanical -
for any purpose without written permission from Mitel Networks Corporation.

TRADEMARKS

The trademarks, service marks, logos and graphics (collectively "Trademarks") appearing on Mitel's Internet sites or
in its publications are registered and unregistered trademarks of Mitel Networks Corporation (MNC) or its subsidiaries
(collectively "Mitel") or others. Use of the Trademarks is prohibited without the express consent from Mitel. Please
contact our legal department at legal@mitel.com for additional information. For a list of the worldwide Mitel Networks
Corporation registered trademarks, please refer to the website: http://www.mitel.com/trademarks.

Windows and Microsoft are trademarks of Microsoft Corporation.

Other product names mentioned in this document may be trademarks of their respective companies and are hereby
acknowledged.
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2 Application Support Plugins

Overview

Phone Manager Professional License contains plugins available that are able to directly integrate with a range of well
known CRM and PIM applications. The plugins generally provide deeper, more seamless integration than other
methods as they leverage the APIs of the specific application.

Features

There are 4 features that the plugins can provide. Depending on the application that is being integrated with,
only some features may be available with varying levels of support and there may need to be integration work
performed by the application vendor or administrator of the system. See the application integration document
for the specific plugin for details.

Dial out directly from the application: For example having a dial button next to a telephone number
field.

Screen popping: Searching the application for contacts that have matching caller ids and displaying
the record.

Call history: Creating a call history phone call activity in the application with the call details.

Calendar and DND synchronisation: Controlling the DND state of the extension based upon calendar
entries in the application.

["5 If multiple features are required then a new application support set up is needed for each one. E.g. screen
pop and call history are required, an application plugin needs adding and configuring for each one.

Configuration

/v, If the configuration of the CRM application is changed from using the standard fields, field types or
formatting or it is customised then this may affect the operation of the product plugin.

] If the CRM installation path is required by the plugin this may vary based on whether the machine is 32bit
or 64bit. The default location of c:\program file (x86) may need to be changed.

To configure a plugin for one of the application support features:

Hpod =~

From the Application Support Configuration section.
Click on the New button.
From the list of Applications select the application to integrate with.

This will then change configuration on the right hand side to show the specific configuration required for
this plugin. See the relevant integration document for details.

Select the Feature to enable either:
o Screen pop
o Call history
o Calendar / DND sync

Multiple features can be enabled for each plugin by repeating the process from step 1.

Select the event trigger that will cause the feature to be acted on (this is not applicable to Calendar /
DND sync).

Page 3



Mitel Phone Manager

o Direction: inbound, outbound or both.
o State: call ringing, call answered, call cleared, call cleared only when answered or user
controlled (i.e. via a toolbar button).

o Type: external, internal or both.

8. Click on Save.
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3 Goldmine

Overview

This describes the features that are available when integrating with Goldmine.

Supported Versions
The following Goldmine versions are supported.

Version Supported
Goldmine v2018.1 (SQL)

Goldmine v2017.1 (SQL)
Goldmine v2016.1 (SQL)
Goldmine v2015.1 (SQL)
Goldmine v2014.2 (SQL)
Goldmine v2013.1 (SQL)
Goldmine v9.2 (SQL)

Goldmine v8.0 (SQL)

Goldmine v7.0 (SQL)

CO0O0O0O00O00

Features

Integration supports the features listed below:

e Click to dial - TAPI

e Click to dial - GM+

e Screen pop for contacts

e Automatic call history entry

e Calendar & DND synchronisation

Click to dial - TAPI

Goldmine supports dialling out directly from a Contact using the highlight and dial feature or using TAPI.
To configure this within Goldmine from the Tools -> Options menu select the Telephony tab as shown.
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TTESTS Optians @

| Perzonal | Record I Calendar I Schedule I Alarmz I Lookup I E-tail
T elephany | FPager I Syztem I Speller I Login

FEE Thiz folder allows wou o control the wanouws zettings for your PC's modern and your
@ dialing options from GaldMine.

bodem Settings SoftPhone [SIP Client)

TAFILine: |5:Mitel PhoneManager — ~| | SIP Settings... |

[ Start SoftPhone with GoldMine

I Diialing Properties I I Line Properties J )
[ Usge SaoftPhone by default 4

Drial Mumber Formatting

@ Let TAPI format phone numbers Dial Prefis: i
1 Dial numbers az entered Crial Suaffis: ¥
Local Area Code: 0000 Hangup after: 30 5| zec.

[ ] ] [ Cancel

Then select the Phone Manager TAPI option from the TAPI Line drop down box in the Modem Settings. Contacts can
then be dialled by either right clicking on the Phone description field (i.e. Phone 1, Phone 2 or Phone 3) and selecting
Dial or clicking on the button from the toolbar menu — this dials the Phone 1.

/&, See the Phone Manager User Guide for TAPI requirements

Click to dial - GM+

Goldmine supports dialling out directly using a GM+ View that converts the telephone numbers into clickable
hyperlinks that call the number when selected.

When using Goldmine and TAPI for outbound dialling Goldmine displays addition dialogue boxes that "pop-up" within
the Goldmine user interface, these additional dialogue boxes cannot be disabled within Goldmine. Using the GM+
View does not cause these boxes to be displayed or have any of the limitations of using TAPI, including unable to use
in a multi-user environment.

GM+ Views once created change their content based upon the currently selected contact within Goldmine making it
ideal for creating hyperlinks. GM+ View tab will need to be enabled by a Goldmine system administrator for clients,
and can only be edited / created by a Goldmine Administrator.

- Relationships Details MNotes GM +View Pending History Opportunities Projects Cases

| Create Web Fom |

The GM+ View tab can have multiple "Templates" associated with it, this allows the user to select which information
they wish to see. These templates can be static or rules based. A full explanation of templates is NOT covered by this
document.
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When creating a template you will be provided with the Goldmine template editor, the first step should be to click the
HTML editor button to change it to its HTML editing view (Highlighted in red in the image below).

rl:l:-:-:_.: - :
(W - T IRB([ B U(ASAZA(EEN |V EQ
T:mplate Name: |SIF Test

The following HTML snippet can be pasted into the editor:
<a href="sip://&lt;&lt; &amp;phonel&gt; &gt;">Call &lt;&lt; &amp;phonelsgt; &gt;</a>

This snippet when viewed via the GM+ View in Goldmine will provide a SIP URI link containing the phone number
contained in the Phone1 field of the current contact, and will dynamically change based on the selected contact.
Addition entries can be added to the GM+ View template containing Phone2, Phone3 fields from Goldmine by editing

the above examples substituting phone1 with either phone2 or phone3. If a phone field has no number then a blank
call entry will be shown.

| b )| 858 % | (G e | [ o = | [ Comman = ][ oo = | [ s ]

et Ackiwaly - Lokt Aty :

Lask ol
Company: Wil Prome 1. +40 1250 030000 Ent Ik ikt
Contact: Amionin Prone 3 B i Facsbook:
haa Migding Phawrsg J Ea oy Tuiar
Pl L Ea bt
Dt Emal Froatal Codder
fos Yish Sge: oy
ot oty
Rt Tyrm e Dipmey
Irnchustry. Bt Mgy Mo
w | Relatesiaps Dennly | et G e Ftrapeng ey et Frggeas Lot

| Craate et Fom. |

Call+44 1230 420000

Screen pop for contacts

The Goldmine contacts can be screen popped directly within Goldmine when an incoming call is received using the
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caller id or from an outgoing call using the dialled number. The telephone number is then used to find any matching
contacts that have this number. For example an inbound call is received from 02071975186 as shown on the toaster.
The plugin performs a search on the contacts to find any records that have matching telephone numbers. A match
was found and the contact record was automatically displayed.

»
| 5 a8 X | [Cummunicalav ] [ Schedule - ] [ Complete ] [ AddTo - ] [ Massaé
1
Mext Activity - 25/03/200010:30 Last Activity : 18/09/2000 10:36 Last Note :
Company: Mitel Phone 1; +44 1291 430000 Eut: Address
Contact: Gary Fisher Phone 2 Ext: Address:
Laszt: Fisher Phone 3 Eut: City:
Prefis: Gary Fa Ext: State:
Dept: Sales E -mail Posztal Code:
Title: Sales Manager wheb Site Country:
Source:
Recaord Type: Interest: Open:
Industry: Acct Mar erge:
v Relatinnships Details | | .Nntes | .GM+\u'iew . Pending | History Opportunities | | .Prnjects | .Cases
- +44 1291 430000
D_._[*]|Ti_.[*] Contact~||U_[v||A _[*]R_[*|R__ »  Preview
T[] , frl|ju.[]|a [+]R. [+] EI . 411201430000
18/09.. 10:36  GaryFisher MAST.. Callln ACK  GoldMi.. | contact: Gary Fisher, +44 1251 420000 j
Company: Mite|
fosecaad Assigned: MASTER (FrontRange Solutions Empla), 10:36,
18/09/2000 =
Commen Contact Set Num [Mitdl |25 July 2014 [12.27 Llear call

If multiple matches are found then the first Contact found with this telephone number will be displayed.
Contact fields

The range of telephone numbers that are to be searched for can be configured. By default the common telephone
number fields are pre selected.

Field Name Enabled?

Account Number
Phone 1

Phone 2

Fax Number

All Telephone Fields

0000

Telephone number formats

Goldmine does not provide a standard format for storing telephone numbers within the system by default. The plugin
supports searching for multiple different formats dependent on the region (UK or US) where the client is running. The
default formats for the UK and International are shown below. This is based on the number 08001831234 been
searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234
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The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats

9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210 (987)654-3210

Automatic call history entry

Phone Manager can work with the History within Goldmine and can have Call Completed entries automatically
created for calls made or received by the User when a match has been found to an entry in their contacts. The
contact to associate with this is found using the caller id received or dialled number.

The notes section of the call entry is populated with the information shown.

LﬂF Completed Outgoing Call =] =
Contack: Ackivibye: Lser:
ISarah Shart j j ICaII ot j IMiteI j [ Private
Reference;
I Unanswered Cal IE
Opporkunity | Project: O Case
Il{nu:une]l j Mew | I(nune} j Mesw |
Code: Resulk: Date: Time: Cwr akion: Success:
| [+ [M [12i0erz014 o] [12:12 [ ] [oocoo:o0 ] [successtu =]
Mokes:

B/ U|ZA %V
Phone number:+44 1291 430000 =
DDl
DDl Name:
Direction: Outbound Account Code: LI
[@ (] 4 I Zancel |

Phone number For inbound calls this is the caller ID and for outbound calls this is the dialled
number.

DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.

DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

Direction The direction of the call.

Account Code The account codes that was set on the call.

Trunk For external calls the outside network trunk number that the call was made or
received on.

Transferring Extension The device that the call was transferred from.

Duration The duration of the call. The call event trigger must have been set to Call End

as they are not known until the call is cleared.

Call Recording If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
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browser). The call event trigger must have been set to at least Call Answered

as the call recorder will only create the recording id when the call has been
answered.

Calendar & DND synchronisation

The calendar within Goldmine can be synchronised with the DND status of the extension of the User. For example
when there is an appointment in the calendar and this is due the extension can be automatically placed into DND with

the DND text set to the Reference field of the appointment. When the appointment ends, the extension will be
automatically removed from DND.

For example the Appointment entry below will place the Users extension into DND between 09:00 and 16.30 with the
DND text set to "Sales Meeting".

uly 2014]
Appaintrment = & Gk Mail
Calendar *
@6 X6 | toul 1o~ | e _omos - | [ty o) [em ) ]
25 July 2014 Tazk
=]
Iz Tormnaz Mendoza: Sales Meeting
KN - i3
ocagion | Catege
k- Day | Weekl Monthl Yeall ol F'Iannell "8 I:Iutlinel Rz Feg Bnardl
Common Contact Set Num [Mitel |25 Jub 2014 1433

Configuration

The integration needs to be configured for the correct version of Goldmine that is running. From the Version tab select
the relevant entry from the drop down list.
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GoldMine™

Settings | Fields

Wersicn Goldmine v2013.1 (S0L) W
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4 Maximizer

Overview

This describes the features that are available when integrating with Maximizer.

Supported Versions

Version Supported

2015 (v13.0) Desktop Client @

Features

Integration with Maximizer supports the features listed below:

e Screen pop
e Automatic call history entry

Screen pop

Company, Individual and Company Contact records can be screen popped directly within Maximizer when an
incoming call is received using the caller id or from an outgoing call using the dialled number. The telephone number
is then used to find any matching records that have this number. For example an inbound call is received from
7774441111 as shown on the toaster. The plugin performs a search to find any records that have this telephone

number. A matching Company entity was found and the associated record was automatically displayed within
Maximizer.

@)= mnn):
—"'j Home Edit View Search Tools Reports Setup - O3 X
7 Address Book Entry = | ¢ D = SIEW ) [ L %
| Case ' AR
: . Email Mote . | /Phone Schedule| Insert/| Time Assign to
Opportunity i - - Print~ | aTask | Campaign
Create Write Track Subscribe
» Columns:  *Default Address Book View = [ﬂfﬁ
w Mame & Phone Mumber Email Address City
= [ MITEL [227) 555-dddd
2
Ld)
(&
E 1| i 3
5] dade. e [Hla [¥lolfsr (O] Hotes | j=iUser Defined Fislds o Documerts  [gaddress Boak Ord...
TS g
2] Columns: *Default Coi Show: <All> ~ 4 % [¥ ShowAll Filte k
| Mame: aned Phone hurmbe ¥ ¥ Date Time: Type  Text 7774441111 00:02
% 3 MITEL -p April 7, 2015 944 PR Outgoing  Phone Call: Pape, Luka ;
~ | we (22205554444 ! § . T . el Rt -
:[D (777 4441111 April 7,2015 43 PM Cutgaing Ehlnnnla Call.lli\’IITlél:__“ . 7774441111
Eé Pape, Luka
2 (222) 555-4a444
< [ | | m | 3
(= B {3 )| PressFiforHelp  User MASTER | Tuesday April 7,2015  9:47 PM -=51 S
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If multiple matches are found then the Multiple Matches window is shown and enables the User to select the correct
record to be displayed. For example a call is made to 222555444 and this has found three matching records, a
Company Contact, Company and Individual record that have this telephone number.

FMultiple Contacts Found EI@

¢~ Company Contact: Andrew Bamber
-~ Company: Mitel
i Individual: Candice Langlais

Display

The correct record can then be highlighted and then clicking on the Display button will open this associated record.
Automatic call history entry

The plugin supports the ability to be able to automatically create a Maximizer "Phone Call" Note. The record to
associate this with is found using the caller id received or the number dialled.

The record is automatically created with the information relating to the call entered into the relevant fields.

Phone number For inbound calls this is the caller ID and for outbound calls this is the dialled
number.

DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.

DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

Direction The direction of the call.

Account Code The account codes that was set on the call.

Trunk For external calls the outside network trunk number that the call was made or
received on.

Transferring Extension The device that the call was transferred from.

Duration The duration of the call. The call event trigger must have been set to Call End

as they are not known until the call is cleared.

Call Recording If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

Configuration

Authentication
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The database authentication details used to connect to the Maximizer database are configured on the Authentication
tab.

B Maximizer
Authentication | Recards

Logon Details

Enter a Maximizer username and passuord

sername MASTER

WA

Password

Enter a valid Maximizer Username and Password into the relevant fields.
Records

The type of records to include when performing a search can be controlled on the Records tab.
B Maximizer

| Details |.ﬂ~uthenticatiun| Records |

Search Records

Select the type of Companies
entities to include
when searching

Alternate Cont
Alternate Individuals
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5 Microsoft Dynamics CRM

Overview

This describes the features that are available when integrating with Microsoft Dynamics CRM.

Supported Versions
The following Microsoft Dynamics CRM versions are supported.

Version On-premise deployment Internet-facing deployment (IFD) Microsoft Online

s @ @
o @ @
s @ @
oo @ @

Dynamics 365 n/a n/a
(2016)

C0000

Features
Integration with Microsoft Dynamics CRM supports the features listed below:

e Screen pop for contacts
e Automatic call history entry
e Calendar & DND synchronisation

Screen pop

CRM Contact, Account and/or Lead entities can be screen popped directly within CRM when an incoming call is
received using the caller id or from an outgoing call using the dialled number. The telephone number is then used to
find any matching entities that have this number. For example an inbound call is received from 7774441111 as shown
on the toaster. The plugin performs a search to find any records that have matching telephone numbers. A matching
Contact entity was found and the record was automatically displayed using the Users default browser.

Page 15



Mitel Phone Manager

Isa Sastre 2
al
CONTACT =
Luka Pape s
p Isa Sastre
~
Summary
CONTACT INFORMATION
Full Mame * Luka Pape POST
lob Title
Company Mame & MITEL
Email
Business Phone 2225554444 7774441111 00:02
Mobile Phene 7774441111 7774441111
Fax
Preferred Method o Any
Address - .
S H Clear call

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct
record to be displayed. For example a call is made to 222555444 and this has found three matching Contact entities
that have this telephone number. This also will then show the any related entities, in this example the Account the
contact is associated with.

Multiple Contacts Found

Results

E Contact: Pippa Crane

. - Account: BUSINESS CONTACT
|- Contact: Alberto Puga
. i Account: BUSINESS CONTACT
[~ Contact: Aurora Rojas
‘... Account: BUSINESS CONTACT

2225554444 00:01
2225554444

Display @

Clear call

The correct Entity can then be highlighted and then clicking on the Display button will open this record.

I%I The plugin will only search for Accounts and Contacts that are in the Active state. If any records have been
Deactivated then they will not be displayed.

Entity and matching options
Configuration options are available on the plugin that allow the type of Entities to be used in the searching to be set.

For example it can be configured so that only the Contact Entities are searched. These options are set on the Options
tab
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Mg Microsoft Dynamics CRM

Settings | Server | Profile | Options | Call Details | Activitie * | ¥

Screen Pop

Accounts Contacts Leads

Mo Match Options
Display blank entity Type |contact v

[] Custom Search

If no match is found then the Custom Search option can be selected and this will display a form to allow the user to
enter the first name, last name, date of birth or post code and these values will then be used to try and find any

matching records.

o] Advanced Search = =

A
First Name || | Last Name
Postal/Zip [ ] Check Date of Bith  2014-03-1C

Display

If still no match is found when searching for an Entity than a blank form can be automatically displayed to create a
New Entity. The Type of Entity, Contact, Account or Lead that is created can be set here.

Advanced options

The Advanced tab allows control over if related Entities of a matching Contact, Account or Lead are shown in the
Muiltiple Contacts Found window.

Adg Microsoft Dynamics CRM

Account Fields | Contact Fields | Lead Fields | Advanced |+ | ¥
Related Searches

[] Search for related entities

Select the related Entites to search for:

Cpportunities Incidents / Cases Tasks

Any related Entities that have their statecode as Open (for Opportunities & Tasks) or Active (for Incidents/Cases) will
then be displayed in the Multiple Contacts Found window. Selecting these related matches in the Multiple Contacts
Found window and clicking DIsplay will then pop this record.
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Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Contact, Account or
Lead Entities individually. By default the common telephone number fields are listed on the Leads Fields, Contacts

Fields or Account Fields tab.

Mg Microsoft Dynamics CRM

Account Fields | Contact Fields | Lead Fields | Advanced | £ ¢

Select the CRM
contact telephone
numbers to search

These are the default field name and descriptions and may be different if they have been customised. Contact your

Business Phone
Home Phone
Telephone3

Fax

Assistant Telephone
Manager Telephone
Muobile Telephone

Microsoft Dynamics CRM administrator for details.

Contact Entities

Field name

Business Phone

Home Phone

Telephone3

Fax

Assistant Telephone

Manager Telephone

Mobile Telephone

Pager

Primary Address Phone 1

Primary Address Phone 2

Primary Address Phone 3

Account Entities

Field name

Main Phone

Field description

telephone1
telephone2
telephone3d

fax

assistantphone
managerphone
mobilephone

pager
address1_telephone1
address1_telephone2

address1_telephone3

Field description

telephone1
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Other Phone telephone2

Fax fax

o0

Lead Entities

Field name Field description Enabled?
Business Phone telephone1 .a
Home Phone telephone2 .a
Other Phone telephone3d .a
Fax fax .a
Mobile Phone mobilephone .a
Pager pager .@

Telephone number formats

Microsoft Dynamics CRM does not provide a standard format for storing telephone numbers within the system by
default. The plugin supports searching for multiple different formats dependent on the region (UK or US) where the
client is running. The default formats for the UK and International are shown below. This is based on the number
08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats

9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210 (987)654-3210

Call details

The call information that is used to search for matching records can be configured. By default the dialled number or
the caller id are used to search with, depending on the call direction, but other call details can configured. There are
options for the direct dial number or the direct dial name (or DNIS) as shown.
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Ay Vicrosoft Dynamics CRM

Profile | Options | Call Details | Activities | Account Fields | * | ¥

Information

Select the call details to Caller 1D (CLI)

use for the search, Multi [ ] Direct Dial (DDI/DID)
select items to use more [ ] OMIS/DDI Name
than cne and re order the
itemns in preference of
search crder.

[rEI Caller ID represents either the caller ID for inbound calls or the dialled number for outbound calls.

The configuration box lets you select multiple different types of call detail with the details to be used having the check
box next to each one selected. The order of the searching can also be configured by dragging and dropping the entry
and ordering the list accordingly.

When multiple call details are used the searching will stop as soon as a match is found with the first call detail.
Automatic call history entry

The plugin supports the ability to be able to automatically create and display a Microsoft Dynamics CRM Phone Call
Activity entity. The Entity to associate this with is found using the caller id received or the number dialled, and if
multiple matches are found then the Multiple Contacts Found window is shown as for the screen popping. The
telephone numbers used to search are set in the screen popping section.

The Activity record is automatically created with the information relating to the call entered into the description field
and the related entities are linked as shown.
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Ay 1 Outbound Outboun... | « H
Al

»' MARK COMPLETE 3 CLOSE PHOME CALL = COMVERTTO - VX DELETE  wss

PHOME CALL ™

Outbound Answered

Priority Due Status™® Owner*
Mormal 772372014 11:11 AM Open Sergio Araya
Subject™ Qutbound Answered
Call From ™ IR sergio Araya
Call To* Sergio Araya
Phone Mumber +44 1201 230000 Direction Outgoing
Description
Phone number: +44 1291 430000
DDI:
DDl Name:
Direction: Qutbound
Account Code:
Trunk: 94308
Transferring Extension:
Call Recording: http://callrecorder/default.aspx?recid=1574601
Phone number For inbound calls this is the caller ID and for outbound calls this is the dialled
number.
DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.
DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.
Direction The direction of the call.
Account Code The account codes that was set on the call.
Trunk For external calls the outside network trunk number that the call was made or
received on.
Transferring Extension The device that the call was transferred from.
Duration The duration of the call. The call event trigger must have been set to Call End
as they are not known until the call is cleared.
Call Recording If integrating with a call recorder then this can contain a URL link to the call

recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

The plugin configuration has several options that can be set to determine how the record is created.
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Mg Microsoft Dynamics CRM

Server | Profile | Options | Call Details | Activities | Accou * | ¥
Call Activity Record
[] Complete Activity Record
Display Activity Record

Complete Activity Record: This will set the status of the Activity to be Completed.

Display Activity Record: This will display the Activity form, if this is not set then the record will be created without the
user seeing the form.

Calendar & DND synchronisation

The calendar within Microsoft Dynamics CRM can be synchronised with the DND status of the extension of the User.
For example when there is an appointment in the calendar and this is due to start the extension can be

automatically placed into DND with the DND text set to the Subject field of the appointment. When the appointment
ends, the extension will be automatically removed from DND.

There are several options to be able to control the types of Activities that cause the extension to go into DND. The
Priorities tab allows Activities with a specific priority to be included or excluded.

Ay Microsoft Dynamics CRM

Lead Fields | Advanced | Activities | States = Prorities b s
Activity Pricrities
Select the CRM Low
activity priorities to Mormal
include, High

The States tab allows only Activities with specific states to be included or excluded.

Mg Microsoft Dynamics CRM

Lead Fields | Advanced @ Activities | States | Prorities D
Activity States
Select the CRM Busy
activity states to Out of Office
include. Free
Tentative
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The Activities tab allows specific types of Activities to be included or excluded.

Ay Microsoft Dynamics CRM

Lead Fields | Advanced | Activities | States | Prorities I
Activities
Select the CRM Appointment
activity fypes to Task
include. Service Activi

Phone Call

Fax
Letter

Configuration

Application Support

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and

allow access to Dynamics CRM.

Settings and versions

tab.

Ay Microsoft Dynamics CRM

Settings | Server | Profile | Options | Call Details | Activitie * | *

Information

Version | MSCRM 6.0 (2013) x4

Test...

Server connection

The specific connection details to the CRM server need to be set on the Server tab.
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Mg Microsoft Dynamics CRM

Settings | >erver | Profile | Options | Call Details | Activitie * | ¥
Server Details

Discovery Server mitel3.server.com
Does this server use S5L7

Crganisation Mame Mitel

Enter the friendly organisation name (found at the
top right hand corner of the page in CRM),

Discovery Server: This is the URL of the Microsoft Dynamics CRM discovery server. This is normally the same as
the CRM server. Contact your administrator for details on what this should be.

For the Microsoft hosted version use the following based upon the organisation location.

Location Discovery Server

North America crm.dynamics.com

North America 2 crm9.dynamics.com
Europe, Middle East and Africa (EMEA) crm4.dynamics.com
Asia Pacific Area (APAC) crmS.dynamics.com
Oceania crm6.dynamics.com
Japan (JPN) crm7.dynamics.com
South America crm2.dynamics.com

Does this server use SSL: If SSL/HTTPS connection is required to connect to the CRM system enable this option.

Organisation Name: This should be set to the organisation name configured for the company that will be used to
integrate with. This should match the exact name shown in the top right hand corner of the CRM web page when you
are logged in.

; Miles Jarvis
Ay 1 SALES v Contacts | v New Contact @ Mitel m

Authentication and profile details

The Profile tab enables the security credentials used to access Microsoft Dynamics CRM to be configured.
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Ay Microsoft Dynamics CRM

Settings | Server | Profile | Options | Call Details | Activitie * | ¥

Details
[] Use Integrated Windows Authentication [IWA)
Using Cffice 365 Account to Login?

Username: nachowvalencia@mitel.co.uk

PES.SWDrlj: (AL ALl Ll)

Use Integrated Windows Authentication: If this is set then the username, password and domain details from user
who is logged on the computer will be used.

A Using Integrated Windows Authentication is NOT supported when using IFD and claims based authentication.

Depending on the configuration of Microsoft Dynamics CRM and how it is accessed will determine what options are
required.
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6 Microsoft Dynamics NAV

Overview

This describes the features that are available when integrating with Microsoft Dynamics NAV.

Supported Versions

The following Microsoft Dynamics NAV versions are supported.

Version Client Supported
v4.0 SP2 Classic Client @
v5.00 Classic Client @
v6.00 (2009) Classic Client @
v6.00 (2009 R2) RoleTailored Client @
v7.00 (2013) Web Client @
v7.00 (2013 R2) RoleTailored Client @
v8.00 (2015) Web Client @
v8.00 (2015) RoleTailored Client @
v9.00 (2016) Web Client @
v9.00 (2016) RoleTailored Client @
v10.00 (2017) Web Client @
v10.00 (2017) RoleTailored Client @
Features

Integration with Microsoft Dynamics NAV supports the features listed below:
e Screen pop

Screen pop

Microsoft Dynamics NAV Contact or Customer cards can be screen popped directly within NAV when an incoming
call is received using the caller id or from an outgoing call using the dialled number. The telephone number is then
used to find any matching entities that have this number. For example an inbound call is received from 7774441111
as shown on the toaster. The plugin performs a search to find any records that have matching telephone numbers. A
matching Contact was found and the card was automatically displayed within the NAV client.

This example shows the RoleTailored Client.

Page 26



Application Support

_ My View - Contact Card - CTO00145 . Roberto Rivero =] -= =]
1~ Home Actions Navigate Report Mitel @
/" 11 Create Interact \

“ 1= New |7 Sales Quotes (oA
Edit Appl Contact

oply -
7% Delete Template.. ¢ Statistics Cover Sheet

CT000145 - Roberto Rivero

General ~ | * 0 Links Al P

No.: CT000145 Past Code: - Link Address Descrip

Type: Person - Country/Region ... -

Company M., CT000142 - Search Name: ROBERTO RIV...

Company M. Mitel Phone MNo.: 222 555 4444 @

Marne: Roberto Rive... | ... Salesperson Code: -~ |% E

Address: Salutation Code: LIMNISEX -

Address 2: Last Date Modifi.. 0470872014

City - Date of Last Inter... I p—rT— 3

County: Last Date Atternp.., et N \'

Mext To-do Date: | 4
Click here to create 3 new note, | 7774441 1 “] "] 00:02

Lines v

Communication ~ Sl
Phone No.: 222555 4444 |G E-Mail: £

tabile Pho... TIT 4441111 @ Horne Page: @ -

Clear call

This example shows the Microsoft Dynamics NAV web client, the matching contact is shown using the Users default
browser settings.

Wiew - Contact Card - CTO00145 . Matthieu Gagnon B

Horne Actions MNavigate Report General | Manage |

/“ Wiew j M Create Interact y
m Mews [T Bales Quotes LLLTL

Close  Edit Apply Contact Cover
KDeIete Template.. | Statistics Sheet
Manage Process Report
General ~ | 3
Mo, CTO00145 Country/Region Code
Type Person Search Marne MATTHIEL GAGNCN
Company Mo, CTO00142 Phone Ma. 222555 4444
Cormpary Marme MOTO GP Salesperson Code
Marme Matthieu Gagnan Salutation Code UMNISEX
Address Last Date Modified 04082014 =|
Address 2 Date of Last Interaction
City Last Date Atternpted
County Mext To-do Date
Post Code
I Lines v
Communication Al B
Phone Mo, 224 555 4444 E-tdail

Faobile Phaone Mo, TIT 4441111 Home Page

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct
card to be displayed. For example a call is made to 222555444 and this has found three matching Contacts that have
this telephone number.
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Fultiple Contacts Found EI@

- Contact: RoDerte Rivera
- Contact: Mark Laird
L Contact: Shana Bouchard

%

2225554444 00:01
2225554444

Display @

Clear call

The correct entry can then be highlighted and then clicking on the Display button will open this card.
Entity and matching options

Configuration options are available on the plugin that allow the type of cards to be used in the searching to be set. For
example it can be configured so that only the Customer or Contact Entities are searched. These options are set on
the Options tab.

Selecting the Create record on no match? will create and open and new card of the type that has been selected.

Ay Microsoft Dynamics NAV
|"-.I'l.-"ehsite | Contact Fields | Custu:umerFieIds| Options | Call [ 4] ¢

Screen Pop
Custamers Contacts
Create record on no rmatch? [Cu:untact v]

| @ If no match is found then no records will be displayed.

| |‘E“-'|‘ The Web client supports creating a blank contact if there is no match on a call, however, the RTC client does not.

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Contact or Customer
cards individually. By default the common telephone number fields are listed on the Contact Fields and Customer
Fields tab.

These are the default field names and may be different if they have been customised. Contact your Microsoft
Dynamics NAV administrator for details.
Contacts

Field Description Field name Enabled?
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Phone Number Phone No_ .{9
Mobile Phone Number Mobile Phone No_ .{9
Fax Number Fax No_ .{9
Telex Number Telex No_ .@
Pager Number Pager .@
Customers

Field Description Field name Enabled?
Phone Number Phone No_ .{9

Telephone number formats

Microsoft Dynamics NAV does not provide a standard format for storing telephone numbers within the system by
default. The plugin supports searching for multiple different formats dependent on the region (UK or US) where the
client is running. The default formats for the UK and International are shown below. This is based on the number
08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats

9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210 (987)654-3210

Microsoft Dynamics NAV stores the country code and area code parts of each telephone number separately from the
main number. From the Formats tab the country and area codes can be set to be appended to the telephone number
when a search is made.

Call details

The call information that is used to search for matching records can be configured. By default the dialled number or
the caller id are used to search with, depending on the call direction, but other call details can configured. There are
options for the direct dial number or the direct dial name (or DNIS) as shown.
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Ay \Vicrosoft Dynamics NAV

| Contact Fields | Custorner Fields | Optiu:uns| Call Details ik
Information

Select the call details to Caller ID {CLD

use for the search, bdulti [ Direct Dial (DDL/DIDY
select iterns to wse more |:| DMIZDDI narne)
than one and re arder the
iterns in preference of
search arder,

I‘él Caller ID represents either the caller ID for inbound calls or the dialled number for outbound calls.

The configuration box lets you select multiple different types of call detail with the details to be used having the check
box next to each one selected. The order of the searching can also be configured by dragging and dropping the entry
and ordering the list accordingly.

When multiple call details are used the searching will stop as soon as a match is found with the first call detail.

| él This field name must be the same with both Contacts and Customers.

Configuration

The integration needs to be configured for the correct version of Microsoft Dynamics NAV that is running.

Ay Microsoft Dynamics NAV

Wersion | S0L Server | Authentication | Yifehsite | ContactF| * | *

Properties
Version | N&Y 7,00 (2013 RZ) RTC Client |
Server Type 0L Server
Company Mitel

From the Version tab select the relevant entry from the drop down list. Then select the correct Server Type for the
type of NAV server that will be used, this can either be SQL Server or Navision and depends the on the version of the
NAYV selected.

Authentication
The Authentication tab enables the security credentials used to access Microsoft Dynamics NAV to be

configured. Select the Use Integrated Windows Authentication option if the username, password and domain details
from user who is logged on the computer will be used.
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Ay Vicrosoft Dynamics NAV

|‘ufersi|:|n | S0L Server| Authentication |Wehsite | ContactF 4 | *

settings
se Integrated Mifindows Authentication

Username lsername

Passurord

Depending on the configuration of Microsoft Dynamics NAV and how it is accessed will determine what options are
required. For example if a different user account is used to access NAV than what is currently logged into the
computer then they will need to be manually entered.

Advanced

You may need to edit the default path to Dynamics NAV in the Phone Manager plugin when using Phone Manager in
the following scenarios

e Phone Manager is running on a 32 Bit PC
e Phone Manager is running on a 64 Bit PC and using a 64 Bit version of the Dynamics NAV Client

Mg Microsoft Dynamics NAV

Version MAV Advanced SOL Server Authentication Wel * | *
Connection Type

Select the connection [nettype) used to connect.

(@) TCP (O TCPS (O NETE

Path

MAY Install Path |C:\F‘ru:ugram Files (x26)\Microsoft [

SQL Server connection

If the Server Type has been configured as SQL Server then the connection details for the SQL Server needs to be
entered.
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Ay Microsoft Dynamics NAV

Wersion | QL Server ‘.&uthenticatiun | Wiehsite | ContactkF 4 | ¢

settings

Server Mame
Database Mame

Server Address

nawserveryBNAWDERO
Demo Database MAY (T-0)

navserser TI46/DynamicsMAWT

The Server Name is the hostname of the SQL Server database, this should also contain any instance names if been

used, for example:

e navserver\NAVDEMO

This will connect to the NAVDEMO database instance on the server with the hostname of navserver. This correct
value for this can be found using the Microsoft Dynamics NAV Administration tool.

-

ﬁ Microsoft Dynamics Maw Server - [Console Root\Microsoft Dynamics MAY (LocaltDynamicsMAWT]
G File  Action  Wiew Window Help

&= | x#1E BE

| Console Root

4 i Wicrosoft Dynamics NAY (Local DynamicsNAYY0 - (Running)
A DynamicsHAWTD

General

Credential Type:
Database [nstance:
Database Mame:

Database Server:

Miata Marhe Siver

Windows -
MAVDERMO
Demo Database Mo (7-M

MAVServer
q

The Database Name option is the name of the SQL Server database to connect to and can also be found using
the Microsoft Dynamics NAV Administration tool.

Web server

The Website tab enables the web server details to be configured for the Microsoft Dynamics NAV Web client

connection.
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Ay Microsoft Dynamics NAV

| Wersioh | SOL Server | Suthentication | Wiebsite | ComtactF| 4 | *

MAY Webhserver Details

Server Mame dynamicsnaviill

Zerver Port a0an

[] Use HTTPS/SEL ta connect

Application Support

Enter the Server Name of the Microsoft Dynamics NAV web server and the Server Port to connect with, the default is
8080. If the connection to the web server is using a secure HTTP connection then check the User HTTPS/SSL to

connect option.
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7  Microsoft Internet Explorer

Overview

This describes the features that are available when integrating with Microsoft Internet Explorer.

Supported Versions

Version Supported
° @

v10 @1

v11

iaa1

' Metro style not supported

Features

Integration with Microsoft Internet Explorer supports the features listed below:

e Screen pop

Screen pop

Microsoft Internet Explorer can be screen popped directly when an incoming call is received or an outgoing call is

made and the call detail information can then be used to embed into the URL. For example an inbound call is
received from 7774441111 as shown on the toaster. The plugin was configured to screen pop using the

URL "http://www.google.co.uk/search?q=%OutsideNumber%" and this then replaced the placeholder
%OutsideNumber% with the outside number - for incoming calls this is the caller id.

= =l

[ https://wwnr google.couk/search?q=T77441111 O ~ & € || [E] 774441111 - Google Search > 5o 5%
Google  7r744a1111 | a | [“sanin | A
Web Maps Images Shopping Videos More ~ Search tools ﬂ
EQB results (0.40 seconds)
0% v

\
7774441111

7774441111

00:02

Clear call

Settings

The configuration options for the plugin on the Settings tab allow the URL configuration options to be set.
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& Internet Explorer

Settings

Web Page

URL http:/fwww.google.co.uk/search?q=%:0utsic

Frame

Title

Cpen in new window

URL: This is the URL that will be popped. This can include any of the supported placeholders listed below.

Frame: The plugin can update a specific web frame with the configured URL, enter the name of the frame here.

Title: The plugin can update a web page that is currently open, enter the HTML title of the page here.

Open in new window: Enable this option to open a new Microsoft Internet Explorer window if there is not one open

or if there is one open the create a new tab for each pop.

Placeholders

The list of supported place holders are shown below. These should be enclosed in % chars in the URL configuration.

Detail

CalllD

OutsideNumber

ActualCLI

DDI

DDI4

DDIName
AccountCode
Extension
AgentID

Trunk
SpeedDialName
HuntGroup
HuntGroupName

Display

Description

This is a variable-length string of characters (0-9, @, #,*, P, F, or X) the
phone system assigns to each call. This ID serves as a reference
identifier so that multiple simultaneous calls can be tracked through the
system. The same ID is assigned to a call until the call is terminated,
even if the call transfers between devices. Maximum length is currently
seven characters.

The caller ID or dialled number.

The unformatted caller ID or dialled number received directly from the
PBX.

The inbound DDI/DID number.

The last 4 digits of the inbound DDI/DID number.

The DNIS associated with the DDI/DID number.

The last account code that was entered against the call.

The extension number associated with Phone Manager.

The agent id number associated with Phone Manager.

The outside trunk number that the call used.

The system speed dial name associated with the outside number.
The hunt group that the call came in on.

The name of the hunt group that the call came in on.

The DNIS or DDI/DID outside number associated with the trunk used for
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the call (i.e. was is normally shown on the top line of the keyset display).

TransferredFrom The number of the device the call was transferred from.
TransferredFromName The name of the device the call was transferred from.
LastRedirectionExtension The number of the last device that redirected (forwarded, deflected,

transferred, or recalled) the call, if applicable; otherwise, this is blank.

LastRedirectionExtensionName The name of the last device that redirected (forwarded, deflected,
transferred, or recalled) the call, if applicable; otherwise, this is blank.

TransferringExtension The number of the device that the call was transferred to the. This may
be blank if the transferred call is a conference call.

TransferringExtensionDescription The name of the device that the call was transferred to the. This may be
blank if the transferred call is a conference call.

ContactField1 The contact field 1 match for the matching contact record.
ContactField2 The contact field 2 match for the matching contact record.
ContactField3 The contact field 3 match for the matching contact record.
ContactField4 The contact field 4 match for the matching contact record.
ContactField5 The contact field 5 match for the matching contact record.
ContactField6 The contact field 6 match for the matching contact record.
ContactField7 The contact field 7 match for the matching contact record.
ContactField8 The contact field 8 match for the matching contact record.
ContactField9 The contact field 9 match for the matching contact record.
ContactField10 The contact field 10 match for the matching contact record.
CallRecorderRecID The call recording record ID that can be used to identify the specific

recording for this call.

CallRecorderServerID The call recording server ID that the call was recorded on for this call.

DiallerCampaign The name of the Phone Manager Outbound campaign if this is a dialler
call.

DiallerField1 The Phone Manager Outbound dialler field 1 for this campaign record if

this is a dialler call.

DiallerField2 The Phone Manager Outbound dialler field 2 for this campaign record if
this is a dialler call.

DiallerField3 The Phone Manager Outbound dialler field 3 for this campaign record if
this is a dialler call.

DiallerField4 The Phone Manager Outbound dialler field 4 for this campaign record if
this is a dialler call.

DiallerField5 The Phone Manager Outbound dialler field 5 for this campaign record if
this is a dialler call.

DiallerField6 The Phone Manager Outbound dialler field 6 for this campaign record if
this is a dialler call.

DiallerField7 The Phone Manager Outbound dialler field 7 for this campaign record if
this is a dialler call.

DiallerField8 The Phone Manager Outbound dialler field 8 for this campaign record if
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this is a dialler call.

DiallerField9 The Phone Manager Outbound dialler field 9 for this campaign record if
this is a dialler call.

DiallerField10 The Phone Manager Outbound dialler field 10 for this campaign record
if this is a dialler call.
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8 Microsoft Office 365

Overview

This document describes the features that are available when integrating Phone Manager with Office 365©.

Supported Versions

Office 365© is an online product and has no concept of a version numbering scheme, Phone Manager integration was
tested against the version running in November 2015.

Features

Integration with Microsoft© Office 365© supports the features listed below:

» Screen pop for contacts
* Calendar / DND Synchronisation
+ Call History Entry

Screen pop for contacts

Office 3650 personal contacts can be screen popped when an incoming call is received using the caller id from
the inbound call or the dialled number on an outbound call. For example, an inbound call is received from
07718402534, if a contact exists then it is displayed through the users default web browser:

Dorian Geroux

Dorian Geroux

If multiple matches are found then the Multiple Contact Found dialog is shown.
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Multaple Contacts Found - O i

- =

Contact: Sergio Araya
Contact: Isa Sastre

When searching all the telephone fields with a contact supported by Office 365© are searched for a matching
record. The plugin supports searching for multiple different formats dependent on the region (UK or US) where
the client is running. The default formats for the UK and International are shown below. This is based on the
number 08001831234 being searched for.

UK & International Telephone Formats

08001831234 +44 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234
0800 1831234 0800-1831234 (0800)1831234 (0800)-1831234
(080)018-31234 0800 183 1234

The default formats for the US are shown below. This is based on the number 9876543210 being searched for.

US Telephone Formats

9876543210 19876543210 987-654-3210 1-987-654-3210
987.654.3210 1-987.654.3210 (987) 654-3210 1(987) 654-3210
+1 (987) 654-3210 (987)654-3210

Calendar & DND synchronisation

The personal calendar within Office 365© can be synchronised with the DND status of the extension of the
User. For example, when there is an appointment in the calendar and this is due the extension can be
automatically placed into DND with the DND text set to the subject of the appointment. When the appointment
ends, the extension will be automatically removed from DND.

Busy states The busy status of the appointment can be used to filter what type of appointments will be used to
automatically change the DND status.
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Showr as

Free il

Free
Working elsewhere
Tentative

+ Busy

By

From the Busy Options tab check each entry to include this type of busy status.

] Office 365

Connection Busy Options  Settings

Status
Show these types of appointment
[ ] Busy Away Tentative
Free Warking Elzsewhere

[] Private Events

CallHistory Entry

Phone Manager can work with the notes field within an Office 365© Contact and can have Phone call entries
automatically created for calls made or received by the User when a match has been found to an entry in their
Office 3650 contacts. The contact to associate with this is found using the caller id received or dialled. If
multiple matches are found then the Search Results window is shown as for the screen pop.

JB Tomas Mendoza

Contact MNotes

CLI 2 +44 1291 430000

Call Direction : Outbownd

Call 5tatus : Answered

Start Time ; 1801272015 151557

End Time : 01,/01,/0001 00:00:00

Call Recording : http://mitelrecorder/defaultaspxTrecid=2350716

Configuration
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The integration to Office 365© requires the users individual User Id and password.

] Office 365

Connection  Busy Options  Settings

Office 365 User ID|gary.fisher@ mitel.unmicmaoﬂ

Password |Iiiiiiiil |

There is also an option to show the default contacts page when there is no contact match:

] Office 365

Connection Busy Options  Settings

[] Open Default Contacts Page on 'Mo' Match

Test

Application Support

There is also a ‘Test’ button which will test whether the configured user credentials are correct.

Multi-Factor Authentication

If multi-factor authentication has been enabled on a user's account, an 'Application Password' must be created
for Phone Manager to use. Once created, the application password must be used along with the user's existing

username.
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9 Microsoft Outlook

Overview

This describes the features that are available when integrating with Microsoft© Outlook®.

Supported Versions

The following Microsoft© Outlook®© versions are supported.

Version Supported

-

Outlook® 2010 32bit

-

Outlook® 2010 64bit

N

Outlook® 2013 32bit

Outlook®© 2013 64bit

a

Outlook®© 2016 32bit

a

Outlook®© 2016 64bit

Business Contact Manager for Outlook©

C000000

" Desktop client for Microsoft© Windows

Features

Integration with Microsoft© Outlook®© supports the features listed below:

e Directory import for contacts

e Click to dial

e Meet-Me conference creation

e Screen pop for contacts

e Automatic journal entry

e Calendar & DND synchronisation

e Business Contact Manager for Outlook

Directory import for contacts
Users can enable their Outlook®© personal contacts to be linked into Phone Manager. This enables the contact to be
searched for using the Home, Telephone or Mobile/Cell numbers as well as the first, middle, last or company name
fields directly from within Phone Manager. As there can be other types of contacts shown in the Phone Manager

contacts window, Outlook®© contacts are shown with a icon next to them.
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. Mitel Phone Manager g~ _ 0O X

Candice Langlais

BE6S #

Contacts Call history

Neville Mayor
Sergio Araya
535?%?5.555 4

Fl g

Endpoint 1803 Agent

Once found they can then be dialled using any of the numbers associated with the contact. Clicking on the dial icon
will call the main number but any number can be selected by right clicking and selecting the relevant number to call.

um
um
Sun Shu N\
TI7444111 ) Call control 4 Dial »
TT74441111
Ga[}i_F_lfl?EF K Retrieve Voicemnail 6665554444
8887770066

Frequently accessed contacts can be pinned to the Users favourites directory, by right clicking on the contact entry
and selecting Add to favourites, so that they permanently appear on the contacts tab.

A Only contacts in the users personal folder are available for directory searching and adding to favourites.

Click to dial

Calling a contact directly from Outlook®© is supported when using the Phone Manager Outlook© Add-In. This is
installed by default with each Phone Manager client and adds new entries to the contacts screen within Outlook®©.
When the contact list is open a User can right click on a contact and select the Phone Manager menu and then select
the number to call.
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Ol | FULL MAME BUSIMESS PHONE | MOEBILE PHOME JOB TITLE COMPANY FILE &5
Click here to add a new ...

4 Company: Mitel ; 3 item(s)

&3] Simon Crystal 774441111 B665554444 Mitel Siman Crystal
e Alberto Puga B887TTEEER RARGEGAAAA Mitel Alberto Puga
[Z5]  Shana Bouchard 111222333 @ Copy Mitel Shana Bouchard

#2 Quick Print

83 Forward Contact »

Create 4
Phone Manager  » Business: 8887776666
L cal ’ Mobile: 6665554444
s Categorize r
|* FollowUp 3
b Mowve L4
> Delete

When in the contact list or contact details view at the top the ribbon bar can also be used. From the Communicate
ribbon, select More and then Phone Manager.

r o - IE;I
13 -
L S
Email Meeting | Mare —| | Move Mail Forwarc
= Merge | Contact
Communica Current View Actions
. E
O@ [FULLN Phone Manager Business: 8887776666 OB TITLE COMPANY
Click here to add a new ..,
Mobile: 6665554444
4 Company: Mitel: 3 item(s)
=] Mile Joubert 7744411 BE65554444 Mitel -
EJ  Marco Moreno 8887776666 6665554444 Mitel
[E5  PippaCrane 1112223333 6665554444 Mitel

| @‘ This requires Phone Manager to be running in the same Windows session as Outlook®©.

Meet-Me conference creation
Creating a new Meet-Me conference appointment directly from Outlook® is supported when using the Phone

Manager Outlook© Add-In. This is installed by default with each Phone Manager client and adds new entries to the
calendar screen within Outlook®©.
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= Calendar - Qutlook

HOME Mew Tab

Mew

Appointment Meeting ltems -

Mew

June 2014

WE TH FR SA
28 29 30
4 5 & 7
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18 19 20 21
25 26 27 23

July 2014
WE TH FR sA
ZNE N 5
9 10 11 12

SEMD / RECEIVE

5 fend LR

Mew Mew

Meeting
Phone Manager

k
5U
1
8
15
22
29

5U
b
13

FOLDER VIEW

SEARCH TOOLS

SEARCH

Today Mext7 Day | Work Week Month Schedule
Week View

Days

GoTo

Create a new meeting

Pl

E% Phone Manager Add-In

Tell me more

08

09

10

Arrange G

/2014

TUESDAY
1

When selected, a new appointment is displayed that is pre populated with the telephone number and access code to
dial into a Meet-Me conference.

B H

-

APPOINTMENT IMSERT FORMAT TEXT REVIEW
: @ x g Calendar E E‘) :‘..;.e M Eusy ~ | €% Recurrence ==I " Q
: Sglvnesg-l Delete EE,Foru\rard . Appointment S;I::il;:;::lg At::r;:i;nzes 15 minutes | @ Time Zones Cate%nrize 'b Zaoom i
Actions Show Attendees Options Pl Tags Zoom ~

Subject Meeting: i
Location hMeet Me Audio Conference -
Start time Man 30/06/2014 E 08:30 - All day event
Endtime | Mon 30/06/2014 FE| |10:00 -

Internal: tel://1300
External: tel://

Access Code:

Screen pop for contacts

To join the Mitel Meet Me Audio conference please dial one of the numbers below and enter the access code:

The Users local or public contacts can be screen popped directly within Outlook© when an incoming call is received
using the caller id or from an outgoing call using the dialled number. The telephone number is then used to find any
matching contacts that have this number. For example an inbound call is received from 7774441111 as shown on the
toaster. The plugin has then performed a search on the Outlook® contacts to find any records that have matching
telephone numbers. A match was found and the Outlook® contact records was automatically displayed.
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FCE ™ | N Helene Moulin - Contact ? 5 - 0O
CONTACT INSERT FORMAT TEXT REVIEW

EWJ-)J x R save8iNew - [ElGeneral [ AlFields [ Email E-_ Qi 5;0) Dﬁ 10 Categorize -
B e
B3 Forward - F‘DDETE”S FEMaeting @ L g ™ Follow Up -
Save & Delete ° 2 Address Check  Business Picture
Close ~ Certificates ¥ More~ Book MNames Card - Private
Actions Show Communicate MNames Options Tags Zoom
Full Mame... Helene Moulin Helene Moulin
i Mitel
Company Mitel
1111 Work
Job title 54444 Maobile
File as Moulin, Helene -
Internet
[} E-mail... -
Display as Hotes

Web page address
IM address

Phone numbers

Business... - 773441111
Home.. 5 7774441111 i
Business Fax., | = 7774441111
Mobile... - 2225554444
Addresses
Business.. b
This is the mailing Clear call

If multiple matches are found then the Search Results window is shown and enables the User to select the correct
contact to be displayed. For example a call is made to 222555444 and this has found three contacts that have this
telephone number.

(] SearchResults = =

ResLits

.- Contact: Nacho Valencia, Mitel [\\nacho.valencia@mitel.comcontacts]
- Contact: Chiara Tremblay, Mitel [\\chiara.tremblay@mitel.cormcontacts]
" Contact: Maureen West, Mitel [\\maureen.west@mitel.com'contacts]

+44 1291 430000
+44 1291 430000

Display

©

Clear call

Double clicking on the relevant contact or highlighting and clicking on the Display button will show the required
Outlook® contact.

Contact folders

The Users local Outlook© contact folder is used when trying to find any matching contacts (Default). Additional
Outlook® Public folders can be added to the search from the Contacts tab in the configuration.

To enable public folders to be searched check the Search Public Contact Folders option and then click on the Refresh
button. This will list all of the available public folders for this User and then the appropriate options can then be
selected.

/i Using public folder searching may require additional time to perform the search and could delay any matches
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~ from being found.

Contact fields

The telephone number fields that are to be searched can be configured for the contacts from the Fields tab in the
configuration.

B4 Outlook

Profile | Contacts | Fields | Call Details | Busy Options | O 4 | ¥

Select the Cutlook Assistant ~
telephone numbers Business
to search Business 2

Business Fax W

[] Show Blank Contact

Multiple search matching

The list shows all of the available telephone number fields and if they are enabled for searched by default. These are
the default field names and descriptions and may be different from the ones shown in Outlook®©.
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Outlook Outlook Field Name Enabled?
Description
Assistant AssistantTelephoneNumber

Business BusinessTelephoneNumber

Business 2 Business2TelephoneNumber

Business Fax BusinessFaxNumber

Callback CallbackTelephoneNumber

Car CarTelephoneNumber

Company CompanyMainTelephoneNumber
Home HomeTelephoneNumber

Home 2 Home2TelephoneNumber

Home Fax HomeFaxNumber

ISDN ISDNNumber

Mobile MobileTelephoneNumber

Other Fax OtherFaxNumber

Pager PagerNumber

Primary PrimaryTelephoneNumber
Radio RadioTelephoneNumber
Telex TelexNumber

TTY/TDD TTYTDDTelephoneNumber

S X xR 1 X I N i N NI X X0 I X I I <IN %)

Unmatched Contacts

If no matches are found then a blank contact can be shown with the outside number pre populated into the Business
telephone field. Check the Show Blank Contact option to enable this, or uncheck (Default) to not do anything when no
match is found to a call.
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2 HJ :
CONTACT INSERT

@ x B Save & New ~
& Forward -
Save & Delete
Close
Actions
Full Mame...
Company
Job title
File as
Internet
EE E-mail... -
Display as

Web page address
IM address

Phone numbers

FORMAT TEXT REVIEW
[2=] General = Al Fields
[ Details

2 Certificates
Show

Business.. - 3332221114
Haome... -
Business Fax... -

Untitled - Contact T EH - O X
& Email slal ..': o1 11 Categorize ~
! - [,
F‘@Meeting v@ '*// : [™ Follow Up ~
= Address Check  Business Picture :
¥ Mare ~ Book MNames Card T Private
Communicate MNames Options Tags Zoom ~

3332221114 Work

Motes

Multiple search matching

When more than one contact is matched and the Multiple search matching option is checked (Default) the Search
Results window is displayed to the User to allow them to select the relevant contact. If this option is not checked then
the first match found will be used and any further searching will be stopped. This can be useful when using public
folders to reduce the time taken to perform the search.

Telephone number formats

Outlook® does not provide a standard format for storing telephone numbers within the system by default. Depending
on the region where the client is running then different formats will be used:

UK & International Telephone Formats

08001831234
08001 831234
080 018 31234
0800 1831234
(080)018-31234

US Telephone Formats
9876543210
987.654.3210

+1 (987) 654-3210

Call details

+44 (0123) 4567890
08001-831234
080-018-31234
0800-1831234
0800 183 1234

19876543210
1-987.654.3210
(987)654-3210

44 (08001)831234
(08001)831234
080 0183 1234
(0800)1831234

987-654-3210
(987) 654-3210

+44 (080)0183 1234
(08001)-831234
080-0183-1234
(0800)-1831234

1-987-654-3210
1(987) 654-3210

The call information that is used to search for matching records can be configured. By default the dialled number or
the caller id are used to search depending on the call direction, but other call details can configured. There are
options for the direct dial number (DDI/DID) or the direct dial name (DNIS).
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B4 Outlook

Profile | Contacts | Fields | Call Details | Busy Options | Q) 4 | ¥

Information

Select the call details to Caller ID (CLI)

use for the search, Multi [ | Direct Dial (DDI/DID)
select items to use mare |:| OISO Mame
than ocne and re order the
itemns in preference of
search order,

Automatic journal entry

Phone Manager can work with the Journal within Outlook® and can have Phone call entries automatically created for
calls made or received by the User when a match has been found to an entry in their Outlook®© contacts. The contact
to associate with this is found using the caller id received or dialled. If multiple matches are found then the Search
Results window is shown as for the screen pop.

B H® s Answered - Journal Entry T EH - O X

FILE JOURMAL ENTRY IMSERT FORMAT TEXT REVIEW

'H_] , X I alml [ 34 Q

— LY e e

- S p Hin ! Yo
Save & Forward Delete Start Pause Categorize Private Address Check  Zoom

Close Timer Timer ] Book Mames

Actions Timer Tags MNames Zoom -

Subject Answered
Entry type Phone call - | Company
Start time Fri 04/07/2014 E 1305 ~ | Duration 0 minutes -

Phone number: 0111222333

DDI: 03332221114

DDI Mame: Sales

Direction: Outbound

Account Code: 655

Trunk: 54309

Transferring Extension: 2001

Contact: Crane, Pippa

Call Recording: hitps://callrecorder/default.aspxPrecid=1556142

| -

The body of the journal item is populated with the information below and the start and duration of the call.

Phone number For inbound calls this is the caller ID and for outbound calls this is the dialled
number.

DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.

DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

Direction The direction of the call.
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Account Code The account codes that was set on the call.

Trunk For external calls the outside network trunk number that the call was made or
received on.

Transferring Extension The device that the call was transferred from.

Contact The Outlook®© contact name in the last name, first name format.

Duration The duration of the call. The call event trigger must have been set to Call End

as they are not known until the call is cleared.

Call Recording If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

Calendar & DND synchronisation

The calendar within Outlook® can be synchronised with the DND status of the extension of the User. For example
when there is an appointment in the calendar and this is due the extension can be automatically placed into DND with
the DND text set to the subject of the appointment. When the appointment ends, the extension will be automatically
removed from DND.

Busy states

The busy status of the appointment can be used to filter what type of appointments will be used to automatically
change the DND status.

B d A T
FILE APPOINTMENT IMSERT FORMAT TEXT REVIEW

@ x E&, Calendar D EII :'.1.‘ Recurrence

Save & Delete L:f‘, Forward - “2pPpointment Scheduling Invite Mone - | & Time Zones
Close Assistant  Attendees =
Actions Show Attendees Options

From the Busy Options tab check each entry to include this type of busy status.
"
@4 Outlook

Contacts | Fields | Call Details | Busy Options | Options| | 4 | ¢

Status

Show these type of appointment
Busy Cut of Office
Free Tentative

Sensitivity options

The sensitivity type of the appointment can be used to filter what type of appointments will be used to automatically
change the DND status. From the Options tab check each of the Sensitivity Options to include this type.
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@z Outlook

Contacts | Fields | Call Details | Busy Options Options R

Sensitivity Options

Mormal Frivate
Personal Confidential
Other

Show All Day Events Include Recurrences

Other options

There are other options that can be used to filter the type of appointments to include. Check the Show All Day
Events include all day events. Check the Include Recurrences to include appointments that are recurring.

Business Contact Manager for Outlook

Phone Manager supports integration with contacts stored within Business Contact Manager for Outlook in the same
way as for contacts that are stored within Public Folders.

/, Business Contact Manager contacts are not available for directory searching and adding to favourites.
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10 NetSuite CRM+

Overview

This describes the features that are available when integrating with NetSuite CRM+ hosted in the Cloud.

Supported Versions

The integration uses NetSuite v2014.1 web services. Although NetSuite tries to maintain backwards compatibility when they
upgrade their cloud platform this is never guaranteed. This version of the plugin has been tested on the latest version that was
available upon release.

Features

Integration with NetSuite CRM+ supports the features listed below:

o Click to dial
e Screen pop for customer and contacts records
e Automatic call history entry

Click to dial

When a record is displayed any telephone numbers will be shown as hyperlinks and clicking the link will call the number
selected.

"L NETSUITE RE

\9 * -"& Activities Payments BoxFiles Transactio

2 Contact Q
Paloma Salamanca MITEL

m Back % +'3 w» Actions ¥

Primary Information

CONTACT COMMENTS
Paloma Salamanca

Email | Phone | Address

EoaaiEd Cup

I (777} 444-1111 I HOME PHONE

See the Click to dial configuration section for details.

| @ This requires Phone Manager to be running in the same Windows session as NetSuite.

gf If the screen popping feature is also been used then this should only be configured for Inbound Calls, so as not to
screen pop on outbound.

Screen pop

CRM Contact and/or Customer records can be screen popped directly within CRM when an incoming call is received
using the caller id or from an outgoing call using the dialled number. The telephone number is then used to find any
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matching records that have this number. For example an inbound call is received from 7774441111 as shown on the
toaster. The plugin performs a search to find any records that have matching telephone numbers. A matching Contact
record was found and the record was automatically displayed using the Users default browser.

"L NETSUITE q ] Q| B+ @ v 1@ Davidsmih s

Honeycomb Mfg - Administrator

\f-) * ﬁ Activities Payments BoxFiles Transactions Lists Reports Documents

2 Contact a «
Sarah Short MITEL

m Back % +'3 v Actions¥

Primary Information

CONTACT COMMENTS CATEGORY
Sarah Shert
MR./MS5... PRIVATE IMAGE
NAME
COMPANY
MITEL
JOB TITLE L8
+44 1291 430000 00:02
Email | Phone | Address
+44 1291 430000
EMAIL OFFICE PHONE ADDRESS
ALT. EMAIL
MOBILE PHONE
MAIN PHONE
+44 1291 430000 HOME PHONE

Clear call

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct
record to be displayed. For example a call is made to 222555444 and this has found 2 matching Contact records and 1
matching Customer record that have this telephone number.

Multiple Contacts Found e

Reslts

Contact: Elina Marie (ID=1648)
-Contact: Sergio Araya (ID=1649)
Customer: MITEL (ID=1649)

+44 1291 430000 00:01

+44 1251 430000

Display

Clear call

The correct record can then be highlighted and then clicking on the Display button or double clicking the entry will open
this record.

g[ The plugin will only search for records that are in the Active state. If any records have been marked as /In Active then
they will not be displayed.

Record and matching options

Configuration options are available on the plugin that allow the type of Records to be used in the searching to be set. For
example it can be configured so that only the Contact records are searched. These options are set on the Options tab.
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L\ NETSUITE

Settings | Account | Optiens | Activities
Screen Pop

Customers Contacts

Mew Record
Display blank record en no match

Type | Contact W

If no match is found when searching than a blank form can be automatically displayed to create a new record. The record
type, Contact or Customer that is created can be set here.

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a NetSuite Phone Call Activity entity. The
record to associate this with is found using the caller id received or the number dialled, and if multiple matches are found
then the Multiple Contacts Found window is shown as for the screen popping.

/& For the Call History entry to be created, the 'Company' field needs to be populated in the target contact.
The Activity record is automatically created with the information relating to the call entered into the relevant fields.

For inbound calls this is the caller ID and for outbound calls this is the dialled number.
Phone number

For external inbound calls only, the DDI/DID number that the call came in on.

DDI/DID
For external inbound calls only, the DNIS of the DDI/DID that the call came in on.
DDI/DID Name
. . The direction of the call.
Direction

The account codes that was set on the call.
Account Code

For external calls the outside network trunk number that the call was made or received
on.

Trunk

. . The device that the call was transferred from.
Transferring Extension

The duration of the call. The call event trigger must have been set to Call End as they

Duration . .
are not known until the call is cleared.

If integrating with a call recorder then this can contain a URL link to the call recording
(this is not a clickable hyperlink but can be copied and pasted into a browser). The call
event trigger must have been set to at least Call Answered as the call recorder will only
create the recording id when the call has been answered.

Call Recording

The plugin configuration has several options that can be set to determine how the record is created.
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L\ NETSUITE

Settings | Account | Options | Activities

Call Activity Record

Display activity record
Complete activity record
Edit activity record

Display activity record: This will display the Activity form, if this is not set then the record will be created without the user
seeing the form.

Complete activity record: This will set the status of the Activity to be Completed.

Edit activity record: This will open the Activity record in edit mode.

Configuration

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and allow
access to Dynamics CRM.

Settings and versions

The supported version of NetSuite can be seen on the Settings tab.

LM NETSUITE

Settings | Account | Options | Activities

Information

Version | pletSuite CRM+ 2014.1 v

Test...

Account details

The specific account details need to be set on the Account tab.
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LM NETSUITE

Settings | Account | Options | Activities

Details
Account ID TSTORY1
Email maurice.abel@mitel.com
p355w Drd EEEEEEEEEE
Role 3

Account ID: This is the NetSuite CRM Account ID. This can be found from the within NetSuite. From the Setup menu
select Integration -> Manage Integration -> Web Services Preferences .

Web Services Preferences

m Cancel Reset
ACCOUNT ID
TSTDRWV1

Email: The email account used to login to NetSuite for this user.

Password: The password used to access NetSuite for this user.

Role: The role to use to connect to NetSuite for this user. This needs to be to the Internal ID of the specific role. To find
the relevant ID, set the Show Internal IDs preference and the internal ID can be found by going to Setup > Users/Roles >
Manage Roles.

NetSuite Configuration

Web services

The integration uses the NetSuite CRM Web Services for the screen pop and phone call activity features. The Web
Services are enabled from within NetSuite and can only be performed by a NetSuite Administrator.

Select Setup -> Company -> Enable Features. In the SuiteCloud tab, scroll down to the SuiteTalk (Web Services) section
and enable the Web Services check box.

Each User that is connecting to NetSuite needs to have the Web Services permission set against their role. To assign the
Web Services permission to a role:

1. Select Setup -> Users/Roles -> Manage Roles.

2. Click either Edit or Customize next to the role.

3. From the Permissions tab select Setup.

4. Add the Web Services permission with the Full level.

Click to dial
To enable the click to dial feature from the telephony integration option needs to be enabled.

Select Setup -> Company -> Enable Features.

In the SuiteCloud tab, scroll down to the Integration (Add-ons) section
Enable the Telephony Integration check box.

For each user, select Settings -> Set Preferences.

Select the Telephony tab.

Set the Telephony Option to be CTI.

2 e o
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7. Enter "tel://{phone}" into the CTI/ URL section.

"\ NETSUITE NE

@ Y /& Activities Payments BoxFiles Transactions Lists Reporis

Set Preferences

m | Cancel | | Reset

General Appearance Transactions  Analytics Activities  Alerts Telephony

TELEPHOMY OPTIONM
CTIl b

TAPI DEVICE

CTI URL
tel://{phone}

NDCCIY T MilAL AT
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11 Sage CRM

Overview

This describes the features that are available when integrating with Sage CRM.

Supported Versions
The following Sage CRM versions are supported.

Version

(2]
c
i)
°
o
=3
©
o

v5.7 -v7.0

v7.1

v7.2

v7.3

000

Editions

(2]
c
T
T
o
&+
]
o

Sage CRM Professional Edition (Cloud)

Sage CRM On-Premise Edition

Sage CRM Essentials Edition (Cloud)

OO

Features

Integration with Sage CRM supports the features listed below:
e Screen pop for contacts

Screen pop

CRM Person, Company and/or Lead entities can be screen popped directly within CRM when an incoming call is
received using the caller id or from an outgoing call using the dialled number. The telephone number is then used to
find any matching entities that have this number. For example an inbound call is received from 7774441111 as shown
on the toaster. The plugin performs a search to find any records that have matching telephone numbers. A matching
Person entity was found and the record was automatically displayed using the Users default browser.
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Person: Hina Mane
Sage CRM % Company: Mitel

Recent Summary Quicklook Marketng MNotes Communicatio
Main Menu Person
Administration 'I;qaasl:_:ehiame:
- Middle:
Title Code:
Find
Territory:

Worldwide

Opt out of E-marketing communications:

New
¥
T Address »
MpCRM Street: City: State:
~ il
'%' Zip Code: Country:
Team CRM
EI Company b
L Name: T 5
Reports M‘i’{:ranv me pES
— Source: Region:
L= Phone
Marketing hWEI?SitE:
Territory:
X Worldwide
Log Off

Phone: 222 555 4444

ns  Opportuniies Cases  Addresses

First Name:  Salutation:

Elina

Suffoc Gender:

Title: Department:
Website: Account Manager:

System Administrator

Phone/E-mail »

Business: 227 555 4444
Mobile: 7774441111
Status:

Segment:

Phone E-mail Seh‘5er\c’iA

_,/ Change

=

j Delete

@"‘ Add to
Contacts
Summary
Report

[=2) Add this
&"!‘; record to a
¥ Group

@ Help

L
7774441111

77744411M

00:02

Clear call

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct
record to be displayed. For example a call is made to 222555444 and this has found three matching Person entities

that have this telephone number.

Multiple Contacts F

Results

[=-Person: Mark Laird
. .Company: Mitel
E| Person: Temas Mendoza
- - Company: Mitel
= Person: Aurara Rojas
- Company: Mitel

ound

Display

2225554444
2225554444

00:01

©

Clear call

The correct Entity can then be highlighted and then clicking on the Display button will open this record.

Entity and matching options

Configuration options are available on the plugin that allow the type of Entities to be used in the searching to be set.
For example it can be configured so that only the Person and Company Entities are searched. These options are set

on the Options tab.

Selecting the Search Related Entities option will enable any matching records that have a related entity to be
displayed on the Multiple Contacts Found window.
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Sage CRM

|‘u"ersiun | Authentication | Formais| Options | Phone Field: * I K |

Select the entities to search Person
Company

Lead

Search Related Entities

| @’ If no match is found then no records will be displayed.

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Person, Company or
Lead Entities individually. By default the common telephone number fields are listed on the Phone Fields tab.

Sage CRM
Authentication | Formats | Options| Phone Fields | Call DEIZ‘I‘

Select the telephone

numbers to search Person Fax
Person Home

Person Mobile

Company Business
Lead Person Phone
Lead Person Fax

These are the default field names and may be different if they have been customised. Contact your Sage CRM
administrator for details.

Contact Entities

Entity Type Field name Enabled?
Person Business @
Person Fax @
Person Home @
Person Mobile @
Company Business @
Lead Person Phone @
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Lead Person Fax @

Lead Alternate Phone @

Telephone number formats

Sage CRM does not provide a standard format for storing telephone numbers within the system by default. The plugin
supports searching for multiple different formats dependent on the region (UK or US) where the client is running. The
default formats for the UK and International are shown below. This is based on the number 08001831234 been
searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats

9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210 (987)654-3210

Sage CRM stores the country code and area code parts of each telephone number separately from the main number.
From the Formats tab the country and area codes can be set to be appended to the telephone number when a search
is made.

ﬂ Sage CRM

Authentication | Formats | Options | Phone Fields | CallDe/ ¥ | *

Telephone Formats

Append Country Code
Append Area Code

For example if the number, 01611234567 is stored within Sage CRM as:

e Country Code: 44
e Area Code: 0161
o Number: 1234567

The following telephone numbers would be searched for:

e |f the Append Country Code and Append Area Code are not set: 1234567
o |f the Append Country Code is set and Append Area Code is not set: 441234567
o If the Append Country Code is not set and Append Area Code is set: 01611234567
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o |f both the Append Country Code and Append Area Code are set: 4401611234567

Call details

The call information that is used to search for matching records can be configured. By default the dialled number or
the caller id are used to search with, depending on the call direction, but other call details can configured. There are
options for the direct dial number or the direct dial name (or DNIS) as shown.

Sage CRM

Formats | Options | Phone Fields | Call Details |

Information

Select the call details to Caller ID (CLI)

use for the search. Multi [ ] Direct Dial (DDI/DID)
zelect items to use more [1 DMIS/DDI Mame
than one and re crder the
items in preference of
search order,

| I‘él Caller ID represents either the caller ID for inbound calls or the dialled number for outbound calls.
The configuration box lets you select multiple different types of call detail with the details to be used having the check

box next to each one selected. The order of the searching can also be configured by dragging and dropping the entry
and ordering the list accordingly.

When multiple call details are used the searching will stop as soon as a match is found with the first call detail.

Configuration

The integration needs to be configured for the correct version of Sage CRM that is running. From the Version tab
select the relevant entry from the drop down list.

Sage CRM

Version | Authentication | Formats | Options | Phone Fields * | *

Properties

Version Sage CRM v7.2 P w

Test

The authentication and server connection details to the CRM server need to be set on the Authentication tab.
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Sage CRM

Version |; | . Formats Options | Phone Fields * | *
Settings
Username | admin Password |
Website
URL http://CRMServer/crm/eWare.dil/
Service WebServices/S0AP

A valid Sage CRM username and password that has the web service option enabled is required to be configured into
the Username and Password fields. To enable a user for web services, from Sage CRM:

1. Select Administration -> Users -> Users
2. Select Change action button
3. In Security panel set Allow Web Service Access field to True

@‘ Only one web service user can logon with the same ID at any given time. If a user tries to logon as another
application, an error will be displayed informing the user that they should first log out. However, it is possible to
logon to the desktop or from a device with the same ID while a Web Service application is running.

The plugin uses the Sage CRM web services to integrate and this needs to be enabled on the Sage CRM server. This
can be enabled from within Sage CRM:

1. Select Administration -> System -> Web Services
2. Select Change action button
3. Check the enable web service option

The web service URL can then be configured into the URL section. For example if the server name is called
mycrmserver then enter:

e http://mycrmserver/crm/eWare.dll/

Troubleshooting

When integrating with Sage CRM v7.1+ the plugin uses the PhoneLink table within Sage CRM and this needs to be
made available through the Sage CRM web service. If this is not enabled this error will be shown in the log files:

System.Web.Services.Protocols.SoapHeaderException:
Request Failed. Entity 'phonelink' is not Web Service enabled.

To enable this follow this procedure:

Log in to Sage CRM SQL Server
Select Sage CRM database
Click on the New Query button
Run:
o update Custom Tables set bord WebServiceTable=’Y’ where Bord Caption
='phonelink®
Run the ISRESET command
6. Login to the Sage CRM system.

PN~

o
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12 SalesForce

Overview

This describes the features that are available when integrating with SalesForce.

Supported Versions

The following SalesForce versions are supported.

Edition Supported

Contact Manager
Group

Professional @E

Enterprise @
Performance @

£ - Additional SalesForce fees may apply

Features

Integration with SalesForce supports the features listed below:

e Screen pop for contacts
e Automatic call history entry

Screen pop

Application Support

CRM Contact, Account and/or Lead entities can be screen popped directly within SalesForce when an incoming call is
received using the caller id or from an outgoing call using the dialled number. The telephone number is then used to
find any matching entities that have this number. For example an inbound call is received from 7774441111 as shown
on the toaster. The plugin performs a search to find any records that have matching telephone numbers. A matching
Contact entity was found and the record was automatically displayed using the Users default browser.
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Setup - Developer Console - Help - Logout ﬁrce con ~
sforce.com Q) O ot Contr
Home | Accounts Cases | Solutions | Reports | Dashboards | »

Contact
Luka Pape
Search &
Help for this Page 2
Search Al - L.
ﬂ Opportunities [01 Cases[0] | Open Activities [0 Activity History [0] Campaign History [0] H
[ Limitto items | own Motes & Attachments [0] | HTML Email Status (0]
Advanced Search... Contact Detail [ edit ] Delete J[ Clone |
Contact Owner  Maureen West [Change Phone  7774441111%
Create New... A
Name  Gary Fisher Home Phone
Account Hame  Mitel Mobile 2225554444 %
Recent Items Title Other Phone
°/ Mark Laird Department Fax
David Smith Birthdate Email
Sun Shu Reports To iew Org Char Assistant C
Lead Source Asst. Phone
& Alberto Puga
e Mailing Other Address
Shana Bouchard Address 7774441111
Youssef Yount Languages Level
" 2 7774441111
X Sergio Araya Created By  Gary Fisher, 25/07/2014 Last Modified Gary Fisher, 25/07/2014
¥ B -
& Gorke Santos 14:52 ¥ 14:52
. Description
&/ Mitel
i [ Edit )] Delete || Clone || Request Update | ]
A4
< >

00:02

Clear call

If multiple matches are found then the Multiple Contacts Found window is shown and enables the User to select the
correct record to be displayed. For example a call is made to 222555444 and this has found one matching Account

entity and three matching Contact entities that have this telephone number.

Multiple Contacts Found — e

- Account: Mitel
Contact: Deborah Green
Contact: Xu Zheng

‘- Conftact: Bastien Beaumont

2225554444
2225554444

Display

00:01

@,

Clear call

The correct entity can then be highlighted and then clicking on the Display button will open this record.

Entity and matching options

Configuration options are available on the plugin that allow the type of Entities to be used in the searching to be set.
For example it can be configured so that only the Contact entities are searched. These options are set on the Options

tab
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:«;‘i]uy%rce.mnw

[ Profile

Security
Screen Pop

Accounts Contacts

Leads

Mew Entity
[] Display blank entity on no match

Type |Contact w
If no match is found when searching for an Entity than a blank form can be automatically displayed to create a New
Entity. The Type of Entity, Contact, Account or Lead that is created can be set here.
Search fields

The range of telephone numbers that are to be searched are not configurable. All SalesForce fields that are have the
phone type will be used.

Step 1. Choose the field type Step1

Specify the type of information that the custom field will contain.

Data Type

®) None Selected

Select one of the data types below.

) Auto Number
) Formula

Q Roll-Up Summary

A zystem-generated sequence number that uses a display format you define. The number is autematically incremented for each
new record.

A read-only field that derives its value from a formula expression you define. The formula field iz updated when any of the
=ource fields change.

A read-only field that displays the sum, minimum, or maximum value of a field in a related list or the record count of all records
listed in a related list.

) Lookup Relationship

Creates a relationship that links this object to another object. The relationship field allows users to click on a lookup icon to select
a value from a popup list. The other object is the source of the values in the list.

O Checkbox

L) Currency

) Date
() DatefTime

) Email

O Geolocation

Allows users to select a True (checked) or False (unchecked) value.

Allows users to enter a dollar or other currency amount and automatically formats the field as a currency amount. This can be
useful if you export data to Excel or another spreadsheet.

Allows users to enter a date or pick a date from a popup calendar.

Allows users to enter a date and time, or pick a date from a popup calendar. VWhen users click a date in the popup, that date and
the current time are entered into the Date/Time field.

Allows users to enter an email address, which iz validated to ensure proper format. If this field is =pecified for a contact or lead,
users can choose the address when clicking Send an Email. Note that custom email addresses cannot be used for mass emails.

(Beta) Allows users to define locations.

[:J Number Allows users to enter any number. Leading zeros are removed.

@l Allows users to enter a percentage number, for example, 10" and automatically adds the percent sign to the number.
O Phone Allows users to enter any phone number. Automatically formats it az a phone number.

) Picklist AowWs USErs [0 Select a valle Tmom & ISt you QeTne.

O Picklist (Multi-Select)
O Text

Allows users to =elect multiple values from a list you define.

Allows users to enter any combination of letters and numbers.

The format of the telephone number does not make any difference as any type of format is supported. The number
dialled/received is used for the searching.

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a SalesForce Phone Task entity. The
Entity to associate this with is found using the caller id received or the number dialled, and if multiple matches are
found then the Multiple Contacts Found window is shown as for the screen popping. The telephone numbers used to
search are set in the screen popping section.

The Activity record is automatically created with the information relating to the call entered into the Comments field
and the related entities are linked as shown.
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Sale‘gﬁrcetcom @ Setup- Developer Console - Help - Logout

v]

Search

| Search Al

v]

[ Limitto items 1 own

Advanced Search...

Create New...

2

Recent Items

;f‘f Luka Pape

2/ Michael Graham

I Candice Langlais

L Paloma Salamanca
& IsaSastre

%/ Gary Fisher

| David Smith

;:-' Xu Zheng

;:.' Youssef Yount
A Mitel

fﬁ Inbound call from 7774441111

Task Edit

@ Save & New Task | Save & New Event

| = Required Information

Task Information

Assigned | Dorian Geroux | Q) status ||InProgress v|
To
subject |Inbound call from 77744< T8 Hame  Contact v||Craig Kenyon | &
DueDate  |25/07/2014 |[25/07/2014] Related | Opportunity v | | &y
To
Phone 77744471111 Email
prorty | Nommal |

Description Information

Comments Start Time : 25/07/2014 15:31:08

End Time : 04/08/2014 15:31:08
Call Recording : http://mitelrecorder/default aspx?racid=1574601

[]Send Notification Email

.conr
ﬁrcc ou | call Cenl-er .

!EE Accounts | Contacts | Cases | Solutions | Reports | Dashboards ;

. Task

Help for this Page

Lal

Phone number

DDI/DID
DDI/DID Name

Direction
Account Code

Trunk

Transferring Extension

Duration

Call Recording

For inbound calls this is the caller ID and for outbound calls this is the dialled
number.

For external inbound calls only, the DDI/DID number that the call came in on.

For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

The direction of the call.
The account codes that was set on the call.

For external calls the outside network trunk number that the call was made or
received on.

The device that the call was transferred from.

The duration of the call. The call event trigger must have been set to Call End
as they are not known until the call is cleared.

If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

The plugin configuration has several options that can be set to determine how the record is created.
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Profile | Security | Options | Activities | Browser
Task Information (for call history records)

Status In Progress

Pricrity Mormal

Display activity record

[[] Use Start and End times only

Application Support

Status: This allows the type of Status for the task to be configured. Valid options are: Not Started, In Progress,

Completed, Waiting on someone else, Deferred.

Priority: This will set the priority of the Task to be High, Normal or Low.

Display activity record: If this is set then the Task will be displayed when it's created in a new browser window.
Use Start and End times only: If this is set then only the start and end time will be populated into the Comments

section for a call history entry.

Configuration

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and

allow access to SalesForce.

User authentication

The plugin requires a valid SalesForce username and password to be entered. These are the details that will be used
for searching and creating history records. Ensure that the user has the appropriate permissions within SalesForce to

do this. As a minimum they need to have the AP/ Enabled flag set on their Profile.

CollaborationFolder
Members

Contacts
Content

Contracts

APl Enabled
Ass=ign Permission
Sets

Author Apex

Bulk APl Hard
Delete

Security

The Security tab enables the type of access and location of the Salesforce services to be set.
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H;l]tj%l‘c&,u T

Profile Security | Options Activities | Browser

Server

URL https://na5.salesforce.com/

Token
[] Use security token

Security Token

Server -> URL: This should be set to SalesForce server that your organisation uses. This can be found by looking at
the URL that is displayed in the address bar of the web browser once you have logged into SalesForce.

(- = https://na3.salesforce.com,/ 0

Token: Depending on the security configuration of SalesForce and how it is accessed will dictate what options are
required. To connect to the SalesForce API requires that the public IP address that the user is connecting from is
configured in the Administration Setup -> Network Access section under Trusted IP Ranges.

Network Access Help for this Page 2

[ Quick Find Q|

Expand All | Collapse All
The list below contains IP address ranges from sources that your organization trusts. Users logging in to salesforce.com
with a browser from trusted networks are allowed to access salesforce.com without having to activate their computers.
Force.com Home

Trusted IP Ranges E
SVSISnNOvETview Action  Start IP Address End IP Address Description
Personal Setup Edit | Del 78.158.57.34 78.158.57.46
My Personal Information Edit | Del 78.158.57.46 78.158.57.46
Email
Import

Desktop Integration
Call Center Settings

Administration Setup

Manage Users

Manage Apps

Company Profile

B Security Controls
Sharing Settings
Field Accessibility
Password Policies

Network Access I

If this cannot be configured, for example if you have remote workers whose IP address changes all the time. Then the
Security Token option will need to be enabled.

To create a Security Token from the Personal Setup -> My Personal Information- > Reset My Security Token section
of Salesforce.com, select the Reset Security Token button. This will send an email to the associated user with their
Security Token.
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Reset Security Token Help for this Page 2

| QuickFind Q|

Expand All | Collapse All

I"‘ - Clicking the button below invalidates your existing token. After resetting your token, you will have to use the

B G Home m new token in all APl applications.

System Overview z z z
When accessing salesforce.com from outside of your company's trusted networks, you must add a security token to your

password to log in to the APl or a deskiop client such as Connect for Outlook, Connect Offline, Connect for Office, Connect
Personal Setup for Lotus Motes, orthe Data Loader.

2 My Personal Information

z 6 Your security token is tied to your password and subjectto any password policies your administrators have
Personal Information

configured. Whenever your password is reset, your security token is also reset.

Change My Password
Reset My Security Token For security reasons, your security token is delivered to the email address associated with your account. To reset and
send your security token, click the button below.

My Groups

Change My Display | Reset Security Token |

Grant Login Access J
Calendar Sharing

The email will contain the token and will look similar to the one shown below:
e y67I1BpMdiBY02RkbDWqwhCEX

This value then needs to be entered into the Security Token section.
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13

SalesLogix

Overview

This describes the features that are available when integrating with SalesLogix.

Supported Versions

The following SalesLogix versions are supported.

Version Supported

Version 7.0

Version 7.1

Version 7.2

Version 7.5 SP2

Version 8.1

*A

>

>

0000

* - Click to dial feature is not supported
A - Requires the Windows LAN client

Features

Integration with SalesLogix supports the features listed below:

Click to dial

Screen pop

Automatic call history entry
Calendar & DND synchronisation

Click to dial

When a record is displayed a new telephone icon is shown on the toolbar and a Dial Phone entry in added to the SalesLogix
Tools menu.

+//Sage SalesLogix - [Contact: Maurice] |Z||E|r5__(|

&

[
T o - O Lot ot B
Contacts Activity Reminder... M Latest Contacts 2 =

Contact: |Hr. Maurice Abel Literature Fulfilment. .. 41111 Frirmary Contact
P Account: Mitel Processes » 54444 Authorized Sery

When the telephone icon is clicked a new window is displayed that shows all of the telephone numbers that are available for
this record.
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E Type Phone Humber

tobile 2225554444 S

| o

Closz || Dial

Selecting any of the rows and clicking Dial or double clicking the row will cause the selected number to be called.

g[ This requires Phone Manager to be running in the same Windows session as SalesLogix.

r‘E?f If the screen popping feature is also been used then this should only be configured for Inbound Calls, so as not to
screen pop on outbound.

/i, This direct dial out replaces the built in TAPI based “Dialler” feature within SalesLogix and should not be used at the
same time.

/i, The SalesLogix bundle is available on request and needs to be installed by your SalesLogix administrator (see
the SalesLogix Bundle section for details)

Screen pop

CRM Contact, Account and/or Lead entities can be screen popped directly within SalesLogix when an incoming call is
received using the caller id or from an outgoing call using the dialled number. The telephone number is then used to find any
matching entities that have this number. For example an inbound call is received from 7774441111 as shown on the toaster.
The plugin performs a search to find any records that have matching telephone numbers. A matching Contact entity was
found and the record was automatically displayed with SalesLogix.

+/ Sage SalesLogix - [Contact: Phil ]

@ File Edit View Insert Schedue Lookup ‘Writke Tools Intelisync  Window Help
@9 Bady Bfdd TR imEgg o
BELEE Contacts = I 4 10f1 » P Lookup Results ¥ EEY =
sdes )| Contact: [Mr. Phil Taylor || work: [777) 4441111 Pimary Cortact h ™
dccount | Mitel || Mobile: [222) 555-4444 L Authorized Servic
Preferred Contact:
Sales b
Dashboard | Asst | | | Home [ ] [[] Do Mat Salicit
r I P = 1| Nther Pl
S (£ | >
Accounts | Drag a tab here ta display a view 7774441111 00:02
@;—ﬂ | tdore Tabs.. ” MotesHistory ” Activities || Literature Requests || Attachments || Lead Sources || Oppoitunities || Processes ” S 7774441111
Contac ™ Bitthelay: ‘ E:| Pager: | | ContactD: -
W ark eting ] Spouse: ‘ | E-Mal 2: | | Impart Sour
Service ] Children: ‘ | E-Mail 3: | | Create Use
Suppart || £ | 12
2 o S T Clear call
28 July 2014 10:34 Administrator SALESLOGLX_EVAL ¢ @ frr)

If multiple matches are found then the Multiple Contacts Found window is shown and enables the User to select the correct
record to be displayed. For example a call is made to 222555444 and this has found three matching Contact entities that
have this telephone number.
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L Multiple Contacts Found

Account=Mitel Contact=Neville
Account=Mitel Contact=Aurcra Rojas
Account=Mitel Contact=Paloma Salamanca

2225554444
2225554444

Display

Clear call

The correct entity can then be highlighted and then clicking on the Display button will open this record.

Entity and matching options

Configuration options are available on the plugin that allow the type of records to be used in the searching to be set. For
example it can be configured so that only the Contact entities are searched. These options are set on the Options tab.

saleslog/x

Settings | Profile | Server | Options | Account Fields | Con| 4 |

Screen Pop

Accounts Contacts [ | Leads

Display
Use Existing View

Display Mode | Default W

When SalesLogix is screen popped the display mode for how any matching records are shown can be configured as shown.
Display
Use Existing View

Dizplay Mode | Default v

Detailz

List
Split
Previous

Selecting the Use Existing View option will use the current view settings. These settings are equivalent to the options
available in the View menu within SalesLogix.

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Contact, Account or Lead
records individually. By default the common telephone number fields are listed in the Leads Fields, Contacts Fields or

Account Fields tab.
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' Options | Account Fields | Contact Fields | Lead Fields | Ad * | *

Selectthe M [ S - |

account telephone Alternate

numbers to search Fax

Toll Free 2

COther Phone 1

COther Phone 2 v

Contact Entities

Field name Enabled?
Work @
Mobile &
Fax
Home @
Other @
Pager
User Field 1
User Field 2
User Field 3
User Field 4
User Field 5
User Field 6
User Field 7
User Field 8
User Field 9
User Field 10

Account Entities

Field name Enabled?

Main @
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Alternate
Fax
Toll Free @
Toll Free 2
Other Phone 1
Other Phone 2
Other Phone 3
User Field 1
User Field 2
User Field 3
User Field 4
User Field 5
User Field 6
User Field 7
User Field 8
User Field 9
User Field 10

Lead Entities

Field name Enabled?
Work @
Home @
Mobile V)
Fax
Toll Free @
User Field 1
User Field 2
User Field 3
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User Field 4
User Field 5
User Field 6
User Field 7
User Field 8
User Field 9
User Field 10

Telephone number formats

SalesLogix does not provide a standard format for storing telephone numbers within the system by default. The plugin
supports searching for multiple different formats dependent on the region (UK or US) where the client is running. The default
formats for the UK and International are shown below. This is based on the number 08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats

9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210 (987)654-3210

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a SalesLogix Phone Call activity. The record to
associate this with is found using the caller id received or the number dialled, and if multiple matches are found then

the Multiple Contacts Found window is shown as for the screen popping. The telephone numbers used to search are set in
the screen popping section.

The activity record is automatically created with the information relating to the call entered into the Notes field and the related
records are linked as shown.
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Complete Phone Call For Nacho Valencia

Complsted: | 26/07/2014 11:05 ] Scheduled: | 28/07/2014 11:05 ]
Ciuration: |EU “w | | rninbes “ | [ Timeless
Uzers Rezources
Result: | L_...]|
Follow-Up [ 150 Meeting... ] [Q Phone Eall...l [ ToDo.. ] [+] Carmy Ower Motes
Contact: | Sastre Isa | O pportunity: | |
Account: | Iditel | Ticket: | |
Regarding: | Inbound call hom 2225564444 w]
Notes Start Time : 28/07/2014 11:05:50
End Tirne : 28/08/2014 12:05:50
Result:
Q Call Recording : http://mitelrecorder/default. as pxIraclD=123456
Friority: | = | Category: | [as] |
Leader: |PFDCESS M anager | Scheduled by Adminiztrator on 28407 /2014 11:0%:52
[ (1] 4 l [ Cancel ] l ]
Start Time The date and time when the call was started.
End Time The date and time when the call was ended.
Result The account code entered on the call.

Call Recording

will only create the recording id when the call has been answered.

Calendar & DND synchronisation

The calendar within SalesLogix can be synchronised with the DND status of the extension of the User. For example when
there is a meeting in the calendar and this is due the extension can be automatically placed into DND with the DND text set
to the Regarding field of the appointment. When the appointment ends, the extension will be automatically removed from

DND.

For example the Meeting entry below will place the Users extension into DND between 09:00 and 16.30 with the DND text

set to "Sales meeting".
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B=IE3

+ Sage Salesl ogix - [Calendar]

%File Edit ‘Wiew Insert Schedule Lookup ‘Write Tools  Intelisync  Window Help = s e

@ @ BT YaR Lwmyg o W 2 R

D ashboards Administrator !
Today

Sales -

m‘l July 2014
Mon Tue wed Thu Fri

Leads T 2z 3 4 5 6
= T8 8 10 11 12 13
-« 14 15 18 17 18 13 20
o 21 22 23 24 B 28 7
Opportunities 91 430000
2z a0on 91 430000
0= eting
= [ Today: 28/07/2014
Activitiss ContactlAccount Regardin
Calendar

€.
> W

Support < |
Administratar SALESLOGIYN_EvAL P &) 25

28 July 2014 11:13

Configuration
For any of the features there needs to be some basic configuration that needs to be performed to authenticate and allow

access to SalesLogix.

Wizard
The Settings tab provides a Quick Setup Wizard to enable these to be easily configured.

saleslog/x

Profile | Server | Options | Account Fields | Con| * | *

Information

Version | SalesLogix 7.0-7.5 SP2 w

Configuration

Cuick setup wizard Setup

Click to test your settings Test

Click on the Setup button to start the wizard.
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Quick Setup Wizard 4
Settings
UUsername || |
Password
SLX Server Mame | SalesLogiServer
Database Name Select database.. W
Part Mumber 1706
Cancel Detect Save

Ensure that SalesLogix is open and then click on Detect and this will complete the form automatically.

Quick Setup Wizard |
Settings
lsername admin
Password
SL¥ Server Name  |SALESLOGIH
Database Name Select databasze.. W
Port Number 1706
Cancel Detect Save

Select the Database Name for the SalesLogix database to use and then click Save. From the Settings tab click on the Test
button to validate the details and a confirmation message will be displayed if the configuration is successful.

Swiftpage (Sage] SalesLogix

"l ) ¥ou are running SalesLogix version 7.2.0.1501 with 1020 account records

If this fails then more options can be configured on the other tabs.
Authentication profile

The Profile tab enables the security credentials used to access SalesLogix to be configured.
saleslog'x

Settings | Profile | Server | Options | Account Fields | Con) * | *
Details
[] Use Integrated Windows Authentication [[WA)

Username: |adrr1|r1|

Password:
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Use Integrated Windows Authentication: If this is set then the username, password and domain details from user who is
logged on the computer will be used.

Depending on the configuration of Sage SalesLogix and how it is accessed will dictate what options are required. For
example if a different user account is used to access SalesLogix than what is currently logged into the computer then they

will need to be manually entered.

Server details

The Server tab enables the server details and database that is to be used to be configured.

saleslog'x

Settings | Profile | 5erver | Options | Account Fields | Con| *

L3

SalesLogix
SLX Server Mame SalesLogixServer
Database Mame Select database..

[] Use advanced settings

SLX Server Name: The server name or IP address of the computer hosting the SalesLogix database.

Database Name: The name of the SalesLogix database to use.
Advanced Settings: Enables the Advanced and Extended tabs for extra configuration options.

Advanced options
The Advanced and Extended tab enables more advanced options to be configured.

| [g[ These options are not normally required to be changed, contact your SalesLogix administrator for details.

saleslog!x

Contact Fields | Lead Fields | Advanced | Bitended
Advanced Settings

Cennect Timeout |0 Locale Identifier |0
Location Mode ReadWrite

Persist Security Info | True
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saleslog'x

Contact Fields | Lead Fields | Advanced | Bxtended B
Extended Settings

Port Mumber |1706 DBIDs |1
RO/RW Password

Server Certifcate

Enable Logging Case Insensitive Find

Sales Logix Bundle

SalesLogix allows for 3rd party integration components to be installed into the SalesLogix environment to provide additional

features. To install the SalesLogix bundle the following steps need to be performed.

1. Run the SalesLogix Administrator Program.

2. Click the Bundles button.

3. Click the Install button.

4. Locate and select the Phone Manager Bundle.

Users Look in: |@ Desktop

Ty @My Docurnents
T M arne Wersid i 2} 3’ My Computer

SalesLogix w7 .05P 1'web [7.01 My Recent
% SalesLogix v7.0'Web .00 Documents Iﬂ T —

SalesLogis v7.0eb Phone | 7.0.0

Libramy @

B = Deskiop
2
Systems [’)
m My Documents

Bundles

I i

28 July 207141221 -
= My Computer

File name: |F'hone Manager.zxb

J C=J

My Metwork  Files of type: | SalesLogix Bundle [*.sxb)

5. Click OK on the Choose Actions To Install window.
6. If prompted select to allow the plugin to be released and select the group to release to.
7. The Phone Manager Bundle should then be displayed in the list.
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flt SalesLogix Administrator - [Bundle Manager] *
@ File Edit “iew Insert Manage Tools Swindow Help -8 x

S0 RBERLAE R &GN G S

= Bundle Manager

sers z
_ LT L5 ¢ 3 &

Install  Upagrade rinztall Defuze  Unlock Fropertiez

A MHame “erzion | Modified Description _ _
| Phone Manager 4.0.0 28/07/201411:58 | Phone Manager 5 alesLogis .Met Estension
| SalezLogis w7 0 5P 1'wWeb |70 21122006 15:32 | SalesLogix web »7.0 Service Pack 1

% | Saleslogm w/.0wWeb F.0.0 13072006 12:02 [SalesLogis Web for 7.0
| Salezlogik v¥.0Web Phone | 7.0.0 2640172006 10:17  [SalesLogix “eb Phone for «7.0

Librany

8. Close SalesLogix Administrator Program.

9.

Installation is complete, open SalesLogix.
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14 SugarCRM

Overview

This describes the features that are available when integrating with SugarCRM.

Supported Versions

Version On-premise deployment Cloud

V6.4 -v7.9 @ @

|‘§“-'|‘ The integration uses SugarCRM Web Services v4.1. Although SugarCRM tries to maintain backwards compatibility
when they upgrade their cloud platform this is never guaranteed. This version of the plugin has been tested on the latest
version that was available upon release.

Features

Integration with SugarCRM supports the features listed below:

e Screen pop for account, customer and lead records
e Automatic call activity entry

Screen pop

CRM Account,Contact and/or Lead records can be screen popped directly within CRM when an incoming call is
received using the caller id or from an outgoing call using the dialled number. The telephone number is then used to
find any matching records that have this number. For example an inbound call is received from 7774441111 as shown
on the toaster. The plugin performs a search to find any records that have matching telephone numbers. A matching
Contact record was found and the record was automatically displayed using the Users default browser.

¥ SUGAR Welcome, Admin ™

Sales Marketing Support Collaboration All

|Home Calendar | Calls | Meetings | Emails | Tasks Contacts|

Recently Viewed:

Actions: §£| Create Contact = §£) Create Contact FromvCard = [=] View Contacts Import Contacts

Note: To send record assignment notifications, an SMTP server must be configured in Email Seftings.

Milo Joubert +| Create
Edit | =
# Overview
Mame: Milo Joubert = {.
Title: Office Phone: 7774441111
Department: Mobile: 7774441111 00:02
Account Name:  Mitel Fax:
= 7774441111
Primary Address: Other Address:
Email Address: -none-
Description: W
€ > Clear call

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct
record to be displayed. For example a call is made to 222555444 and this has found 2 matching Contact records and
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1 matching Account record that have this telephone number.

Multiple Contacts Found ==

o~ Account: Mitel
-~ Contact: Nacho Valencia
- Contact: Bastien Beaumont

2225554444 00:01
2225554444

Display

Clear call

The correct record can then be highlighted and then clicking on the Display button or double clicking the entry will
open this record.

|‘E“-'|‘ The plugin will only search for records that have not been Deleted. If any records have been marked as Deleted
then they will not be displayed.

Record and matching options

Configuration options are available on the plugin that allow the type of Records to be used in the searching to be set.
For example it can be configured so that only the Contact records are searched. These options are set on the Options
tab.

N SUGAR

Settings | Profile | Options | Call Details | Activities | Accoy * |
Screen Pop

Accounts Contacts Leads

Mew Entity
Display blank entity ocn no match

Type |Contact W

If no match is found when searching than a blank form can be automatically displayed to create a new record. The
record type, Account, Contact or Customer that is created can be set here.

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Contact, Account or
Lead records individually. By default the common telephone number fields are listed on the Leads Fields, Contacts
Fields or Account Fields tab.
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Activities | Account Fields | Contact Fields | Lead Fields 1]

Select the CRM Main Phone
account telephone Other Phone
numbers to search Fax

These are the default field name and descriptions and may be different if they have been customised. Contact your
SugarCRM administrator for details.

Contact Records

Field name

Business Phone

Home Phone

Other Phone

Fax

Mobile Telephone

Assistant phone

Account Records

Field name

Main Phone

Other Phone

Fax

Lead Records

Field name

Business Phone

Home Phone

Field description
phone_work
phone_home
phone_other
phone_fax
phone_mobile

assistant_phone

Field description
phone_office
phone_alternate

phone_fax

Field description

phone_work

phone_home
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Other Phone phone_other @
Fax phone_fax @
Mobile Telephone phone_mobile @
Assistant phone assistant_phone @

Telephone number formats

SugarCRM does not provide a standard format for storing telephone numbers within the system by default. The plugin
supports searching for multiple different formats dependent on the region (UK or US) where the client is running. The
default formats for the UK and International are shown below. This is based on the number 08001831234 been
searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats

9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210 (987)654-3210

Call details

The call information that is used to search for matching records can be configured. By default the dialled number or
the caller id are used to search with, depending on the call direction, but other call details can configured. There are
options for the direct dial number or the direct dial name (or DNIS) as shown.

Eﬁlctivities Account Fields | Contact/ * | *

Options

Information

Select the call details to [+#] Caller ID (CLI)

use for the search, Multi [ ] Direct Dial (DDI/DIDY
select items to use more L] DMIS/DDI Mame
than ocne and re order the
itemns in preference of
search crder.
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@ Caller ID represents either the caller ID for inbound calls or the dialled number for outbound calls.

The configuration box lets you select multiple different types of call detail with the details to be used having the check
box next to each one selected. The order of the searching can also be configured by dragging and dropping the entry
and ordering the list accordingly.

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a SugarCRM Call Activity. The record to
associate this with is found using the caller id received or the number dialled, and if multiple matches are found then
the Multiple Contacts Found window is shown as for the screen popping.

The Activity record is automatically created with the information relating to the call entered into the relevant fields.

For inbound calls this is the caller ID and for outbound calls this is the dialled

Phone number
number.

For external inbound calls only, the DDI/DID number that the call came in on.

DDI/DID
For external inbound calls only, the DNIS of the DDI/DID that the call came in
DDI/DID Name
on.
. . The direction of the call.
Direction

The account codes that was set on the call.
Account Code

For external calls the outside network trunk number that the call was made or

Trunk .
received on.

. . The device that the call was transferred from.
Transferring Extension

The duration of the call. The call event trigger must have been set to Call End

Duration as they are not known until the call is cleared.

If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a

Call Recording browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

The plugin configuration has several options that can be set to determine how the record is created.

Settings | Profile | Options | Call Details | Activities | Accon 4 | ¥

Call Activity Record

Display Activity Record
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Display activity record: This will display the Activity form, if this is not set then the record will be created without the
user seeing the form.

Configuration

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and
allow access to Sugar CRM.

Settings and versions

The supported version of SugarCRM can be seen on the Settings tab.

N SUGAR

Settings | Profile | Options | Call Details | Activities | Accol ¥ | ¥

Information

Version | Sugar 6.4-7.1 W

Profile details

The specific account details that will be used to connect to SugarCRM need to be set on the Profile tab.

N SUGAR

Options | Call Details | Activities | Accon * | *

LURL http://mysugarcrmserver

Details

lsername | usernamme

Paszword seaee

URL: This is the URL to the SugarCRM server.
Username: The username of the account used to login to SugarCRM for this user.
Password: The password used to access SugarCRM for this user.
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15 Swiftpage Act!

Overview

This describes the features that are available when integrating with Swift Page Act!.

Supported Versions
The following Act! versions are supported.

Version

v19 (2017)
v18 (2016)
v17 (2015)
v16 (2014)

v15 (2013)

Features

Integration with Act! supports the features listed below:

Click to dial

e Screen pop for contacts
Automatic call history entry
Calendar & DND synchronisation

Supported

0000

Click to dial
When a Contact record is displayed a new telephone icon is shown on the toolbar.
2% Sage ACT! Pro - ACT2013Demo
File Edit WView Lookup Contacts Schedule Write Reports Tools Help
8 =) &
Sage ACT! G . & . =
Back Forward Mew Call Meeting To-Do
Contacts « || £, petail view| £ Listview [4 25 PR SEEE
Lookup 2] [acTDemo % 43 &
! Contact Field:
Phone Ii???ll-ﬂ-ir'l'l'l'l
| Contact | =
Mahile I{ZZZ}EEB—MM
Contains: I ’ |
. |

When the telephone icon is clicked a new window is displayed that shows all of the telephone numbers that are

available for this contact.
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Mobile Phone

e g

¥ Record call history Close | Dial I

Selecting any of the rows and clicking Dial or double clicking the row will cause the selected number to be called.

| @ This requires Phone Manager to be running in the same Windows session as Act!.

When an outbound call is made using this method a call history record can be created and opened once the Dial
command has been selected. To enable this select the Record call history option on the form.

|‘§'-T If the screen popping feature is also been used then this should only be configured for Inbound Calls, so as not to
screen pop on outbound.

/& This direct dial out replaces the built in TAPI based “Dialler” feature within Act! and should not be used at the
same time. To disable the built in “Dialler” feature, from the menu bar select Tools -> Preferences ->
Communication -> Dialler Preferences and un check the Use dialler option.

Screen pop for contacts

The Act! contacts can be screen popped directly within Act! when an incoming call is received using the caller id or
from an outgoing call using the dialled number. The telephone number is then used to find any matching contacts that
have this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin
performs a search on the contacts to find any records that have matching telephone numbers. A match was found
and the contact record was automatically displayed.

|‘§'-T Only 'telephonefield' types are supported when searching for telephone numbers in contacts! If the field type is
not set correctly in ACT! it will not screen pop
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¥ Sage ACT! Pro - ACT2013Demo =131 =l
File Edit View Lookup Contacds Schedule Write Reports Tools Help - e s
G} = »
| o - ab - K51 Search Go
Sage ACT‘ Back Forward | New Call Meeting i _I
Contacts « |[ £ Detail View] &7 List view Tof1 B e E 0O
Lookup = ITC"'DE"”0 = ® 2 &
Contact Field: j=
e Phone |ﬁfm44+1111 _| B
|contact | CH T ONE
hd Mobile |{222}5554444 _|
4« | »
""""" Contact | Amy Dawson _I Fax I _I
@ Welcome Salutation | Amy E-mail I
@ Connections Company _I Web Site I
£ Contads Key Contact [~
%‘: Groups Title I ;I Address I |
:ﬁ Companies Department I ;I I
= calendar . O sl 7774441111 00:02
Task List Documents | Web Info | Sodal Updates | Contact Access | User Fields | Personal Info | 7774441111
Opportunities Marketing Resuts | :
Notes |Hisix)q|I I Acﬁm'h'esl Opportunities I Groups/Comparies I Secondary Coniadsl Relaﬁondwipsl
Reports Dates: [all Dates VI £y Select Users [ Options -
E1G 2 ||[Dae [ Time [Regarding (=]
Lookup: All Contacts |Nohes: 0 |Chr1's Huffman l_ 4 Clear call

If multiple matches are found then the current Act! view be filtered down for the relevant matches. For example a call
is made to 222555444 and this has found three contacts that have this telephone number.

i Sage ACT! Pro - ACT2013Demo o ]
File Edit Wiew Lookup Contacts Schedule Write Reports Tools Help . - = . = S
»»
Sage ACT) Q. . 5
g Back Forward | New Call Meeting = _I
Contacts « | B Detail view| £ List View| |4 il 3of3 I | e B Oy g M7
Lookup ~| [T Edit Mode I_ TagMaode TagAll Untag All | Lookup Selected  Omit Selected Options -
Contact Field: _,:,‘-'J', & |Cm‘rman}r |Cm1‘lac1 |Pi'mne |M0tu'!eP‘hme |Ex'tensin
ICorrtac:t j Jorge Rossi [222) 555-4444
_ILI Carl Pedrosa (77 744-41111 (2X2) 5554444
) I _________ I 4 Walentino Lorenzo ( hbh-4444
#% Welcome

If no matches are found then there is a setting on the Options tab to enable a new Contact record to be created. The
Phone field is set to the number received and this Contact is then displayed.

act!

Version | Fields | Activities Options |

View
¥ Show Private Activties [ Include Recurrences
¥ Show &ll Day Events (with Banner)

I¥ Create new Contact on no match

Contact fields

The range of telephone numbers that are to be searched for can be configured. By default the common telephone
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Act! Description

Business Phone

Mobile Phone

Alternate Phone

Fax Phone

Home Phone

Pager Phone

Act! Field Name
BUSINESS_PHONE

MOBILE_PHONE

ALTERNATE_PHONE

FAX_PHONE

HOME_PHONE

PAGER_PHONE

Automatic call history entry

Application Support

Enabled?

00000

Phone Manager can work with the History within Act! and can have Call entries automatically created for calls made
or received by the User when a match has been found to an entry in their Act! contacts. The contact to associate with
this is found using the caller id received or dialled number.

The body of the call entry is populated with the information shown.

H =
ooy zl
. Type: Call - Resutt: |Call Completed | i
" Contact: | Santos, Gorka [A1 Madrid]; Yount, Youssef [CH Mitel] ;l Contact... |
Date: 220712014 - Time: |11:3:E vI Duration: Ii}minute vI
_ Attachment: | Atach W | i
* Share With: | _| i
;  Record Manager: ITI:}n}‘.r Leroy VI
" Regarding: | Answered =l i
Details:
T @ &) IMiu:rnsnf't Sans Serif -| 8 ~-A-B T UTEEJ =
B L
= |Phone number: 111222333
i [DDI: I
- |DDI Name:
; |Direction: Outbound
L JAccount Code: [
Trunk: 54309
_ |Transfeming Extension: I
Call Recording: hito:/mitelrecorder/default azpx Precid=1572822 =
- ;
I
4 n
t r
L [ Prvate Fallow-up... | oK Cancel | ;
I
g AL
T o]
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Phone number

DDI/DID
DDI/DID Name

Direction
Account Code

Trunk

Transferring Extension

Duration

Call Recording

Calendar & DND synchronisation

The calendar within Act! can be synchronised with the DND status of the extension of the User. For example when
there is an appointment in the calendar and this is due the extension can be automatically placed into DND with the

For inbound calls this is the caller ID and for outbound calls this is the dialled
number.

For external inbound calls only, the DDI/DID number that the call came in on.

For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

The direction of the call.
The account codes that was set on the call.

For external calls the outside network trunk number that the call was made or
received on.

The device that the call was transferred from.

The duration of the call. The call event trigger must have been set to Call End
as they are not known until the call is cleared.

If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

DND text set to the Regarding field of the appointment. When the appointment ends, the extension will be
automatically removed from DND.

For example the Scheduled Activity entry below will place the Users extension into DND between 09:00 and 13.30

with the DND text set to "Sales Meeting".
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il schedule Activity - x|

Options -
- General | Details I Recumence I
Activity Type: Start Date: Start Time: Dwuration:
IMeeting j IEZ-'D?;'EDM j IE'EI':{H} ;l |4 hours 30 minj
c
i End Date: End Time:
|2z2072014 =] [13:30 =] T Use Bamner
|
Schedule \With: 1
ITOH‘;, Marcel [CH TechOMNE]; Scott, Marco [CH TechONE] ;l Contacts w '
E [T Sendinvitation e-mail
Associate With:
[cr TechonE fcme] _|
Regarding:
sales Meeting ;I

Priority: Colour: Ring Mlarm:

i ILD'.I'-.' ""I ._I INu:uaIarm j Schedule For... |
_ I Private oK I e |

T A 00T

There are options to be able to select the type of Activities that trigger the DND change and these are configured on
the Activities tab.

act!

Version I Fields Activities |D|:|1J'ons I

—Status
Select the Act Call
activity types to Meeting
include To-do

EI| .':I:ﬁ"a'it[.l'

The Options tab has settings to control if private activities, recurring activities and all day events will be acted upon.
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act!

Version | Fields | Activities Options |

—Wiew
W Show Private Activties W Include Recurrences
¥ Show &ll Day Events (with Banner)

—Display
V¥ Create new Contact on no match

Configuration

The integration needs to be configured for the correct version of Act! that is running. From the Version tab select the
relevant entry from the drop down list.

act!

Version |Fields I Acﬁviﬁesl Options I

Properties

Select Version

lntialise.ﬂu:tl

Once this has been selected the plugin needs to be initialised with the Act! application. This is performed by clicking
on the Initialise Act button.

I‘él Act! will need to be closed before this can be done.

The plugin uses the Act! plugin framework and when you click Initialise Act the required files are copied into the Act!
plugin folder. If this is not successful then the current user may not have the permissions to be able to copy files to
this location. By default this is:

C:\Program Files\ACT\Act for Windows\Plugins
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16 TigerPaw

Overview

This describes the features that are available when integrating with TigerPaw.

Supported Versions

Version Supported

16.1.07 @
15.2.02 @
14.1.20 @

Features
Integration with TigerPaw supports the features listed below:

e Screen pop for accounts
e Automatic call history entry
e Calendar & DND synchronisation

Screen pop

Account records can be screen popped directly within TigerPaw when an incoming call is received using the caller id
or from an outgoing call using the dialled number. The telephone number is then used to find any matching Accounts
or Contacts that have this number. For example an inbound call is received from 7774441111 as shown on the
toaster. The plugin performs a search to find any records that have this telephone number. A matching Contact
entity was found and the associated Account record was automatically displayed within TigerPaw.

[

2 Tigerpaw [ NS0 L 2014 Tigerpaw]
File Edit “iew Tools Tasks Accounts
=) il . = | -
210 2 ™ UF ~
Psearch S HMTEL x|

= MITEL

m Llser Forum

General Information Phone Mumbers

t arne:; ||"-"|itE'| J Phorne Ext . k 5
# [222) 555-4444 ==
Address 1: L (
e | @J H:::I [F77] 444-1111
Add 2
= 7774441111 o002
City, State: | | j
Zip, Country: | |US.-'1'« j 77744411M
Frimary Rep: =02 [Tomas ] 1 | 1 ¢
Surnrmary
Journal entries Open quotes 0 -
Belated accountz Open opportunities Pa
Open Invoices Open projects 0 - Clear call
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If multiple matches are found then the Multiple Matches window is shown and enables the User to select the correct
record to be displayed. For example a call is made to 222555444 and this has found three matching records, an
Account, and 2 Contacts that have this telephone number.

' tate: l l w1 Lieated |11/2bi2l1d
| 28 Multiple Matches for Phone Mumber (222) 555-4444 ==

M | AccountM ame Contact Mame 0
Tl e

J Mitel Gorka Santos =
E Mitel Zhao Ping

I

n I
b

i i
d
H|

The correct record can then be highlighted and then clicking on the Display button will open this associated Account
record.

I‘él Even though the telephone numbers for a Contact record can be searched for only their
associated Account can be screen popped.

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a TigerPaw Phone Call Task. The
Account to associate this with is found using the caller id received or the number dialled.

I‘él If there are multiple Accounts and/or Contacts with the same telephone number then
the first Account retrieved will be associated with the task.

The Activity record is automatically created with the information relating to the call entered into the relevant fields.

Phone number For inbound calls this is the caller ID and for outbound calls this is the dialled
number.

DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.

DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

Direction The direction of the call.

Account Code The account codes that was set on the call.

Trunk For external calls the outside network trunk number that the call was made or
received on.

Transferring Extension The device that the call was transferred from.

Duration The duration of the call. The call event trigger must have been set to Call End

as they are not known until the call is cleared.

Call Recording If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.
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Calendar & DND synchronisation

The calendar within TigerPaw can be synchronised with the DND status of the extension of the User. For example
when there is an appointment in the calendar and this is due the extension can be automatically placed into DND with
the DND text set to the subject of the appointment. When the appointment ends, the extension will be automatically
removed from DND.

Calendar

The type of Tasks that can be included in the synchronisation can be configured on the Calendar tab.
=7 7 erp :,w;s!‘s

Settings | Profile | Calendar

Task Types
Showe Appointrments Show To-das

[¥] Show Phane Calls

Types
Shonnr Private Showy Global

Show Appointments: This enables Appointment task to be included in the synchronisation.
Show To-dos: This enables To-do tasks to be included in the synchronisation.

Show Phone Calls: This enables Phone Calls tasks to be included in the synchronisation.
Show Private: This enables Private tasks to be included in the synchronisation.

Show Global: This enables Global tasks to be included in the synchronisation.

Configuration

Profile

The database authentication details used to connect to the TigerPaw database are configured on the Profile tab.
=1 l?d_{P:,w;i%

Settings | Profile | Calendar

Details
se Integrated Wifindows Authentication (W2

sernarme:

Password:

Select Use Integrated Windows Authentication (IWA) to use the login details of the current user, or enter the
Username and Password details into the relevant fields.
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17 Zendesk

Overview
Zendesk is an online ticket/customer support CRM; this Document describes the features that are available when

integrating Phone Manager with Zendesk. Zendesk by default only supports one ‘Phone’ field for storing a telephone
number; this is the field that is searched when attempting to find a contact.

Supported Versions

As Zendesk is an online product they have no concept of a version numbering scheme. Phone Manager integration
was tested against the Zendesk V2 API.

Features
Integration with Zendesk supports the features listed below:

e Screen pop for contacts/open tickets

Screen pop

‘end-user’ people or their open tickets can be screen popped when an incoming call is received using the caller
id (CLI) from the inbound call or the dialled number on an outbound call. For example an inbound call is
received from 07718402534, if there are no tickets currently open for this ‘end-user’ then their user profile is
displayed.

& Tewuse

Wl remte] Taak Lhar

End-uses M TestUser -
2

Tickens (0}

Frguevird rborin (99
rrarccgmiialom

o Subgrat Bequeibrd Updartrd L Annigeay
441391 420000

Mo ket in thn view

English

FCNIT 0o )} Casablamcs

11 misfen ago

If multiple matches are found then the Multiple Contact Found dialog is shown:
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Multiple Contacts Found — O et

Display

The Multiple Contact Found dialog will also be shown if the ‘Search Open tickets on Contact Match’ setting is
enabled in the Phone Manager Plugin. The dialog will allow the selection of the specific ticket item to display:

Multiple Contacts Found - O =

Results

[=I- Contact: Test Uiser
" Open ticket:2 some ticket related issue
=I-Contact: test user 2
Open ticket: 3 i have an issue
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Configuration

The integration requires the Zendesk URL and authentication credentials for the user. User password or
authentication token can be used; these are setup on the Zendesk administration by your administrator in the
settings/channel/API section of the Zendesk configuration.

L
“szendesk

Zendesk Connection  Settings

Connection Information

Zendesk URL |}ruurcumpan}r.zendesk.mm |
[] Use Auth Token

Zendesk User D |user@}rnurcnmpan}r.cum |

Pazzword | |

The option to search for tickets and whether to open the screen pop in a new browser window or in the same
logged in session as selected in the setting tab of the integration, there is also a ‘Test’ button which will test
whether the configured URL and user credentials are correct.

e
“3zendesk

Zendesk Connection  Settings

Search Open Tickets on Contact Match

Open Match In MNew Browser

Test
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18 Zoho CRM

Overview

This describes the features that are available when integrating with Zoho CRM.

Supported Versions

Version Cloud

2019 @
2014 @

{Z] The integration uses Zoho CRM Web Services v2019 or v2014. Although Zoho CRM tries to maintain backwards
compatibility when they upgrade their cloud platform this is never guaranteed. This version of the plugin has been tested
on the latest version that was available upon release.

Limitations

The Zoho CRM API limits the number of API requests for a company on a per day limit. When searching over multiple
modules there will be a separate API request for each module.

[rEI Your version of Zoho will determine how many queries you are allowed per day. If you go over that number Zoho will
return an error when sending the query. You will then not be able to make any more queries that day so the screen pop
will not work.

To increase performance it is recommended that you store your telephone numbers in an unformatted string i.e.
08001831234 and turn off the Advanced Searching option, see the Advanced section for details.

Features

Integration with Zoho CRM supports the features listed below:

e Screen pop for contacts, accounts and leads
e Automatic call history entry

Screen pop

CRM Contact, Account and/or Lead entities can be screen popped directly within CRM when an incoming call is
received using the caller id or from an outgoing call using the dialled number. The telephone number is then used to
find any matching entities that have this number. For example an inbound call is received from 7774441111 as shown
on the toaster. The plugin performs a search to find any records that have matching telephone numbers. A matching
Contact entity was found and the record was automatically displayed using the Users default browser.
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m CRM Announcing 8 New Features! Subscription Setup Help ~ =

Home Feeds Leads Accounts Contacts Potentials Campaigns Reports Dashboards Activities Cases

= Edit Delete Clone More Actions ~ .
- Roberto Rivero - Mitel L
“ontact C Nacho 7774441111 00:02
7774441111
EDQ & (777) 4441111

Clear call

v

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct
record to be displayed. For example a call is made to 222555444 and this has found three matching entities, a
Account, Contact and Lead, that have this telephone number.

Multiple Contacts Found ==

o Account: Account Name: Mitel
Contact: First Mame: Dorian, Last Mame: Geroux
i Contact: First Name: Luka, Last Name: Fape

2225554444 00:01
2225554444

=,

Clear call

The correct Entity can then be highlighted and then clicking on the Display button will open this record.

Entity and matching options

Configuration options are available on the plugin that allow the type of Entities to be used in the searching to be set.

For example it can be configured so that only the Contact Entities are searched. These options are set on the Options
tab
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Settings | Profile | Server | Options | Call Details | Activitie *

Screen Pop

Accounts Contacts Leads
Mew Entity

Display blank entity cn no match

Type Contact W

3

Application Support

If no match is found when searching for an Entity than a blank form can be automatically displayed to create a New

Entity. The Type of Entity, Contact, Account or Lead that is created can be set here.

Advanced options

The Advanced tab control how matching contacts are searched for.

/&, Zoho CRM limits the number of calls to its API, and only lets you search for 1 phone number at a time. Zoho
CRM free edition you may only send 250 queries per company per day, meaning if you are searching for the
number 9876543210 in the US, and only searching for the Main Telephone number and only on the Contacts

module, this search will generate 9 queries.

A& ICRM

Account Fields | Contact Fields | Lead Fields | Advanced
Search Options

[] Enable Advanced Search

Enabling Advanced Search will significantly increase
the number of APl queries used per day. Ensure that
your acceunt has encugh capacity for this.

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Contact, Account or
Lead Entities individually. By default the common telephone number fields are listed on the Leads Fields, Contacts

Fields or Account Fields tab.
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Ae ICRM

Call Details | Activities | Account Fields | Contact Fields | [+ | »

contact telephone Mobile

numkbers to search Home Phone
Azst Phone
Other Phone
Fax

These are the default field name and descriptions and may be different if they have been customised. Contact your
Zoho CRM administrator for details.

Contact Entities

Field name Field description Enabled?
Main Phone Phone @
Mobile Mobile @
Home Phone Home Phone @
Asst Phone Asst Phone @
Other Phone Other Phone @
Fax Fax @

Account Entities

Field name Field description Enabled?
Phone Phone @
Fax Fax

Lead Entities

@

Field name Field description Enabled?
Phone Phone @
Mobile Mobile @

Fax Fax

Telephone number formats

Zoho CRM does not provide a standard format for storing telephone numbers within the system by default. The plugin
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supports searching for multiple different formats dependent on the region (UK or US) where the client is running. The
default formats for the UK and International are shown below. This is based on the number 08001831234 been
searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats

9876543210 987.654.3210 +1 (987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210 (987)654-3210

/& Zoho CRM limits the number of calls to its API, and only lets you search for 1 phone number at a time. Zoho
CRM free addition you may only send 250 queries per company per day, meaning if you are searching for the
number 9876543210 in the US, and only searching for the Main Telephone number and only on the Contacts
module, this search will generate 9 queries. To increase performance and reduce queries you can disable the
telephone format searching as described in Advanced section.

Call details

The call information that is used to search for matching records can be configured. By default the dialled number or
the caller id are used to search with, depending on the call direction, but other call details can configured. There are
options for the direct dial number or the direct dial name (or DNIS) as shown.

M ICRM

Call Details | Activities | Account Fields | Contact Fields | Le 4 | *

Information

Select the call details to Caller 1D (CLI)

use for the search, Multi [ ] Direct Dial (DDI/DID)
select items to use more [ ] OMIS/DDI Mame
than ocne and re order the
iterns in preference of
zearch crder.

] Caller ID represents either the caller ID for inbound calls or the dialled number for outbound calls.

The configuration box lets you select multiple different types of call detail with the details to be used having the check
box next to each one selected. The order of the searching can also be configured by dragging and dropping the entry
and ordering the list accordingly.

When multiple call details are used the searching will stop as soon as a match is found with the first call detail.
Automatic call history entry

The plugin supports the ability to be able to automatically create and display a Zoho CRM Phone Call Activity entity.

The Entity to associate this with is found using the caller id received or the number dialled, and if multiple matches are

found then the Multiple Contacts Found window is shown as for the screen popping. The telephone numbers used to
search are set in the screen popping section.
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The Activity record is automatically created with the information relating to the call entered into the relevant fields.

Phone number For inbound calls this is the caller ID and for outbound calls this is the dialled
number.

DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.

DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

Direction The direction of the call.

Account Code The account codes that was set on the call.

Trunk For external calls the outside network trunk number that the call was made or
received on.

Transferring Extension The device that the call was transferred from.

Duration The duration of the call. The call event trigger must have been set to Call End

as they are not known until the call is cleared.

Call Recording If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

The plugin configuration has options that can be set to determine how the record is created.

o5 ICRM

Profile | Server | Options | Call Details | Activities | Accou * |

Call Activity Record

Display Activity Record

Display Activity Record: This will display the Activity form, if this is not set then the record will be created without the
user seeing the form.

Configuration

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and
allow access to Zoho CRM.

Settings and versions

The correct version of Zoho CRM that is used needs to be selected from the Version drop down on the Settings tab.
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B@m ICRM

Settings | Profile | Server | Options | Call Details | Activitie * | *

Information

Version | Zoho CRM 2014 N

Server connection

The specific connection details to the CRM server need to be set on the Server tab.

@@ ICRM

Settings | Profile | Server | Options | Call Details | Activitie * | ¥

Website
URL https://crm.zoho.com
Token Url https://accounts.zoho.com

URL: This is the URL of the Zoho CRM server. Contact your administrator for details on what this should be. Leave
this as https://crm.zoho.com for the hosted version.

Token URL: This is the URL of the Zoho CRM accounts server. Contact your administrator for details on what this
should be. Leave this as https://accounts.zoho.com for the hosted version.

Authentication and profile details

The Profile tab enables the security credentials used to access Zoho CRM to be configured.

B@m . ICRM

Settings | Profile | Server | Options | Call Details | Activitie * | ¥

Details
Username: maurice. abel@mitel.co.uk
Password: TITTTIT
AuthToken Tdcf83a9e350c2fH 571 ccblecdd855f
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Username: This is the Zoho CRM username.
Password: This is the Zoho CRM password for this user.

Auth Token: This button generates an authentication token to log into Zoho CRM. You only need to generate this
once. If you already have an authentication token you may enter it in here. The token is generated by Zoho based on
your Zoho Username and password.

Your Zoho CRM administrator can manage AuthTokens through the settings page under Active AuthTokens setting

shown.

B https://accounts.zoho.com/u/h#setting/authtoken < EV Google pel ﬁ B ¥4 # =
@6 | Accounts | Help~ | Sign Out
Welcome Michael Home Profile Settings Groups

User Profile Photo A

Settings

Manage your preferences and access information.

Active Authtokens
Access and manage all the active secret auth tokens of your account authorized to different scopes.
Remove Selected

# Upload your Profile Photo Scope  Service IP

[ Token e Addrece  Description Frroefid TFrrn e
" Preferences Remove
R ??986d?4-baf4383913aedc38?ec2f992 crmap: BEECI 78.158.57.44 T::s;:snruzirlv:
bﬁlh"e‘:’l't*idc?g?ddress l?;‘dcf8339e350c2f9f5?1006030948551‘ crmapi) EERH /8:138.5/:19 Tgﬂé:&é;iﬁf —
* Authorized Websites O : Mov 18, 2014 Femove
e s d605cac0bacce54c29188dcad7a00fe3 AP CRM - 78.158.57.46 15:04:42 PM
* Active Sessions D i ensmcacnatbsanaao [t 75.155.57.45 i iy BSOS

* Active Authtokens
* Activity History

* Close Account
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19 EMIS (UK only)

Overview

EMIS Web allows healthcare professionals to share and use vital information, so they can provide better, more efficient care;
this Document describes the features that are available when integrating Phone Manager with EMIS Web.

Please ensure that:

e EMIS has been setup to allow Phone Manager integration
e Only one instance of EMIS Web is running on the user's PC at any one time otherwise the integration will not function.

g‘f A separate EMIS licence and support subscription are required. Phone Manager must be running version 5.0.12 or
above.

Supported Versions

N/A. EMIS Web is a hosted environment. The current version is supported.

Features

Integration with EMIS supports the features listed below:

» Screen pop for patients

Screen Pop

Patients can be screen popped when an incoming call is received using the CLI from the inbound call or the dialled
number on an outbound call. For example, an inbound call is received from 07718402534 their Patient information is
displayed.

(—} E s EMIS Web Health Care System - Partner Test CDB20301 - 20301 -~ = x
em

Borm 20-Feb-1972 (44y) Gender Male \ No. 888 888 8888
Usual GP XARIOS, Xarios (Miss)

s Active ¥ RUSSELL, Robin (Mr)

g Configure Homepage
— Run Backup

emISWeb Support Centre My Inddents  EMIS Health
Quick Launch Menu -?g% Organisation Notepad 4 | |User email address required W '?,??
Care Record

% summary £ Consultations Click the "Add Organisation Mote' button at the Failed to authenticate, the Emis RSS feed

A N top of this section to add a note to your requires a valid email address for the logged on

# ' Medication @ Investigations organisation’s notepad. e
Workflow

[E] Workflow Manager Click here to set your email address
Appointments

53 Appointment Book & Plnner
Registration

& Registration
Reporting

ol Population Reporting
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If you already have a patient screen open at the time of the screen pop then the ‘new’ calls patient information will be
displayed, do not forget to return to the previous patient’s information at some point and save any changes into EMIS.

Multiple Contacts Found — O o

-~ Contact: Gil Russell (DOB: 22/08/1972)
.. Contact: Robin Martin Russell (DOB: 20/02/1972)

Displany:

Configuration
Information Tab
The practice's EMIS Org ID needs entering and the NHS area needs to be selected.
enmis health

Information | Login 5.e1:tings|

(®) NHS England

() WHS Wales
Test

Login Settings Tab

EMIS User ID and the API Password (set on installation of EMIS Web) is required, if Auto Logon is selected the plugin
will use the credentials of the user Logged into EMIS Web on the local PC.
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-l
emis health

Information Login Settings ‘

EMIS User ID Karios

APl Password TITITIIIITY)

Auto Logon |5 = EMIS Timeout (Minutes)

The EMIS Timeout (default 20 minutes) is used to define after how long of inactivity (no telephone calls) the plugin will
drop the connection to the EMIS web API.

Testing

Once you have completed all the details you can test the API connection with the test button, if you have Auto Logon
enabled please ensure that EMIS web is running.
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